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1 Getting Started

This documentation describes how to configure and administer SAP GUI for Windows.
i Note

You can find more information in the Frontend Installation Guide, the Security Guide, and the End User

Guide. These documents can be found in the documentation folder of the DVD, on the SAP GUI Family Page
in SAP Community® or in the SAP Help Portal.

SAP GUI Scripting security details can be found in the SAP GUI Scripting Security Guide.
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2 Application Data Directories

Windows offers dedicated directories in which applications can store their application-specific data like
configuration files, temporary files, etc. There are three application data directories:

One is intended for data that should be available to roaming users on whatever machine they log on to. This

is the application data directory located directly below the user profile directory and it can be reached
using the environment variable <$APPDATAS>.

The second application data directory is intended for data that will only be needed on the local machine, i.e.
it will not be missed by a user when he or she logs on to a different machine. The data in this directory is
not available to roaming users. This directory can be reached using the environment variable <
$LOCALAPPDATAS>.

And one directory for files downloaded by the user:< C:\Users\<username>\Documents\SAP\SAP
GUI>

2.1 Roaming User Application Directory

The configuration files of the SAP GUI are located in the roaming user application directory as shown in the
following file/location overview.

6

The local SAP Logon configuration file SAPUILandscape.xml is located in
$APPDATA%\SAP\Common

Input History database:

$APPDATAS\SAP\SAP GUI\History

i Note

The directory for the history database can also be set to another default with the variable

<SetSapGuiHistoryDir> while creating installation packages using the SAP Installation Server
Administration Tool.

The corresponding registry key is

[HKEY LOCAL MACHINE\Software\SAP\SAP Shared] SaphistoryDir on 32bit operating systems
and

[HKEY LOCAL MACHINE\Software\Wow6432Node\SAP\SAP Shared] SaphistoryDir on 64bit
operating systems.

Use type Expandable String Value, do not use string!

Local Tab Order database:

$APPDATA%\SAP\SAP GUI\LocalTabOrder

ABAP Editor Configuration:

$APPDATA%\SAP\SAP GUI\ABAP Editor

Floating Docking Container Configuration:

SAPPDATA%\SAP\SAP GUI\ABAP Editor\Docking
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e SAP GUI Scripts
$APPDATAS\SAP\SAP GUI\Scripts

2.2 Data Migration for End Users

As of SAP GUI for Windows 7.60 Patchlevel 3, a new function is available in the Restore & Clean Up Page [page
79] with which end users can export their local SAP GUI-specific settings and reimport them. This is for
example useful, when the desktop computer of a user is exchanged and the SAP GUI-specific settings should
be reused on the new machine.

The following settings are exported:

e SAP Logon entries of the user (connections, shortcuts, favorites, ...)

e user-specific settings of the SAP GUI configuration in the Windows registry

e security rules created by the user

® input history of the user

® the database with the local tab order created by the user

e settings of the new ABAP editor

® Theme colors settings made by the user (see Setting Theme Color [page 14])

e Add branding image, which the user stored locally (see also Using Branding [page 11]). During import,
the branding image is copied to the old location in the file system. If this does not function, the branding
image is copied to a default location and the user is informed that the settings for the branding image still
have to be adapted.

The Export option opens a dialogue where the user can enter a file name. This file then contains the export of
all the above-mentioned data in compressed form.

i Note
The compressed file is protected by a user-specific password to prevent unintentional transfer to another

user and, thus, to guarantee the consistency of the export.

The Import option opens a dialogue where the user can choose an export file to be imported. Only files created
during an export out of SAP GUI will be displayed as selection

i Note

After confirming the dialogue, all current user settings of SAP GUI will be overwritten. Furthermore, all SAP
GUI windows as well as the SAP Logon have to be closed and restarted after import, so that the settings
can take effect.

To disable the import/export function, use the following registry keys:

[HKEY LOCAL MACHINE\SOFTWARE\WOW6432Node\SAP\General\Appearance]

ImportConfigurationAndSettings ReadOnly [Default: 0]

ExportConfigurationAndSettings_ReadOnly [Default: 0]

SAP GUI Administration
Application Data Directories PUBLIC



2.3 Local User Application Directory

In the local application data directory, temporary files, traces etc. are stored.
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Folder for temporary documents:
$LOCALAPPDATA%\SAP\SAP GUI\tmp

O\ Caution

Documents in the temporary directory will be deleted, when SAP GUI is closed. You can configure the
deletion of files also in other directories. For information on this, refer to the security guide.

Files downloaded by the user:
C:\Users\<username>\Documents\SAP\SAP GUI

i Note

The directory for the downloaded files can also be set to another default with the variable
SETSAPWORKDIR while creating installation packages using the SAP Installation Server
Administration Tool.

The corresponding registry key is

[HKEY LOCAL MACHINE\Software\SAP\SAP Shared] SapWorkDir on 32bit operating systems
and

[HKEY LOCAL MACHINE\Software\Wow6432Node\SAP\SAP Shared] SapWorkDir on 64bit
operating systems

Type: Expandable String Value

A\ Caution

The installer of the SAP GUI for Windows sets this value only, if a value has been specified in the SAP
Installation Server Administration Tool. Therefore, it cannot be assumed that this registry value will
exist on a client PC.

The folders for the temporary and user documents should, therefore, be determined by ABAP
programs using the corresponding methods in the class CL_GUI_FRONTEND_SERVICES. The
temporary document folder can be obtained using the method GET_TEMP_DIRECTORY and the
document directory can be retrieved by means of the method GET_SAPGUI_WORKDIR.

Cache:
$LOCALAPPDATA%\SAP\SAP GUI\Cache

i Note

It would not make sense to have the cache in the roaming directory, because it is a local cache.
Accessing the cache over the network would nullify the advantages that it would otherwise provide:
direct and quick access to an object without a network in between.

Traces:
$LOCALAPPDATAS\SAP GUI\Traces
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e Edge Control
$LOCALAPPDATAS%\SAP\SAP GUI\EdgeUserData
Folder for temporary Internet files downloaded / created by the Edge (WebView?2) browser control. This
folder is only used, if the alternative browser control was activated.
You can activate the Edge control on the Control Settings Page [page 53]. And you can delete the directoy

on the File Lifetime Page [page 66].
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3 SAP Logon Configuration

Before SAP GUI for Windows 740 was released, you had to use the old configuration format for SAP Logon
entries (saplogon.ini, sapmsg.ini, saproute.ini). With SAP GUI for Windows 7.40, the new configuration format
SAP Ul Landscape was introduced. This new format had beend created to simplify the configuration by unifying
the persisted connection and connection configuration data from SAP GUI for Windows, SAP GUI for Java and
SAP BC in a modern and easy way:

® There are less configuration files involved and they are stored in the same directory.

e Configuration files can either be stored locally or on a central server or share.

® Deployment options “pull” and “push” are available.

® The configuration files are the same for SAP GUI for Windows, SAP GUI for Java and SAP BC.

e |f SAP GUI has been used already, the connection data will be migrated automatically into the SAP Ul
Landscape format.

In the interim period (SAP GUI for Windows releases 740 and 7.50), you had the choice between the
conventional or classic installation procedure/configuration format and the new file format SAP Ul Landscape.

i Note

As of SAP GUI for Windows 7.60, the old configuration format is not supported anymore. SAP GUI for
Windows can still handle this old format for compatibility reasons, because there may be external
applications needing this old format, but using SAP GUI for Windows 7.60 with the old format is not
supported. SAP will neither test this format nor correct issues affecting it. Therefore, all installations of SAP
GUI for Windows 7.60 and newer must use SAP Ul Landscape.

See also:

e SAP Ul Landscape Configuration Guide
e SAP Frontend Installation Guide

SAP GUI Administration
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4 Using Branding

You can integrate a company/branding logo in the titlebar of a SAP GUI session. In the SAP GUI Options dialog
(I Visual Design » Branding ), this feature is set read-only by default.

Prerequisites

e The feature cannot be used for Classic Theme.

e The size and format of the logo should be as follows: The optimal height for the picture is 27 pixel. The
shown width can be up to 160 pixel, but only if the height of 27 is not exceeded.
If the picture does not fit in size, then the picture will be scaled so that it fits the optimal height of 27 pixel.
The width will be scaled symmetrically to the maximal allowed height or asymmetrically to fit the maximal
allowed width.

Procedure

1. Torollout the settings to the users, create the following registry keys:

[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance]
[HKEY LOCAL MACHINE\SOFTWARE\SAP\General\Appearance] (32 Bit OS)

UseBrandingImage (REG_DWORD) = 1 (activates the display of alogo in the titlebar of a SAP GUI
session, if a valid path to a branding picture is provided)

BrandingImage (REG_SZz) with path name to picture as value data: C: \<PathToBranding>
\<YourCompanyBranding>.png
By default the branding feature is not editable by the user. Therefore, the users can see the above set

values on the page | Visual Design » Branding 3 in the SAP GUI Options dialog, but they cannot change
the settings because these are read-only.

2. Optional: In order to allow users to set this option from the SAP GUI Options dialog, you need to create the
following registry values:

[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance]

[HKEY LOCAL MACHINE\Software\SAP\General\Appearance] (32 Bit OS)

UseBrandingImage ReadOnly (REG_DWORD) =0

BrandingImage ReadOnly (REG_DWORD) =0

After restart of the SAP Logon, the settings on page [» Visual Design ¥ Branding 3 will be editable. When a

user changes the settings, the SAP GUI Options dialog writes these values to the following registry values
under HKEY CURRENT USER:

[HKEY CURRENT USER\Software\SAP\General\Appearance]
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UseBrandingImage (REG_DWORD)

BrandingImage (REG_SZ)

i Note

The HKEY CURRENT USER values have a higher priority than values under HKEY LOCAL MACHINE.
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5 Setting Logon Language

The default way of setting the SAP logon language is as follows: The logon screen is displayed in the language
set in the backend system. If a user enters a SAP language during logon, this language will be used after logon.
If the user does not enter a language, the language of the user settings will be used as logon language if it is set.
If there is also no entry in the user settings, the language of the system will be used.

The logon language can be predefined in the [F SAP Logon Options ¥ General 3 dialog (option Use SAP Logon
language as default on logon screen) or in the SAP Shortcuts dialog. These language settings are sent during
connection setup to the backend. In this way, already the logon screen is displayed in the desired language and
the language field is prefilled. This functions also in case of an SSO session.

i Note

In a Portal or SAP Business Client environment, where you do not logon via a SAP GUI, an SSO2 cookie is
used for the connection setup. In this case, the SSO2 cookie language is used.

You can switch this language predefinition feature on and off for all or only for certain systems:

e [f you want to switch this feature off for a certain system, define a SAP Shortcut and choose default as
language. Then, the user setting or, respectively, the backend system setting is used.

e If you want a different logon language for a certain system than the one defined as SAP Logon
language, create a shortcut with the corresponding language defined.

e If you want to switch this feature off for all systems, deactivate the corresponding option in the SAP
Logon Options dialog

SAP GUI Administration
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6 Setting Theme Color

It is possible to display the SAP Signature, Blue Crystal, Belize and Quartz/Quartz Dark Themes in different
color schemes. The color setting can be defined in the following ways:

e As SAP GUI Default (set in the SAP GUI options dialog)
e By system and optionally by client (set in the SAP GUI options dialog)
e Asa System default (set via a profile parameter)

The subsections below describe the different color setting possibilities from the administrator’s perspective.

6.1 SAP GUI Default Color

SAP Logon and SAP GUI sessions, which use default color settings configuration on the client machine and for
which no SAP Signature, Blue Crystal, Belize or Quartz/Quartz Dark color is defined on the SAP system, are
shown in the default color.

To rollout the default SAP Signature, Blue Crystal, Belize or Quartz/Quartz Dark color to users, create the
following registry key and values under HKEY LOCAL MACHINE:

[HKEY LOCAL MACHINE\SOFTWARE\SAP\General\Appearance]
[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance] (on64-Bit0OS)
SelectedTheme [REG_DWORD] = 0x1 (SAP Signature Theme)

SignatureDefaultColor [REG_SZ] (Possible values: SAP Gold, SAP Green, SAP Purple, SAP Redor
SAP Signature Default)

Or
SelectedTheme [REG_DWORD] = 0x80 (Blue Crystal Theme)

BlueCrystalDefaultColor [REG_Sz] (Possible values: SAP BC Gold, SAP BC Green, SAP BC
Purple, SAP BC Red Or BlueCrystal for the default)

Or
SelectedTheme [REG_DWORD] = 0x100 (Belize Theme)

BelizeDefaultColor [REG_SZ] (Possiblevalues:Belize Gold, Belize Green, Belize Purple,
Belize RedorBelize forthe default)

Or
SelectedTheme [REG_DWORD] = 0x800 (Quartz Theme)

QuartzDefaultColor [REG_SZ] (Possible values:Quartz Gold, Quartz Green, Quartz Purple,
Quartz RedorQuartz forthe default)

SAP GUI Administration
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Or
SelectedTheme [REG_DWORD] = 0x4000 (Quartz Dark Theme)

QuartzDarkDefaultColor [REG_SZ] (Possible values: Quartz Dark Gold, Quartz Dark Green,
Quartz Dark Purple, Quartz Dark RedOr Quartz Dark for the default)

The default theme color can also be changed via the SAP GUI Options dialog on the page | Visual Design »

Color Settings 1 (if the active theme is one of SAP Signature Theme, Blue Crystal Theme, Belize Theme or
Quartz Theme). The SAP GUI Options dialog saves the settings under the same registry key and values, but
under HKEY CURRENT USER.The HKEY CURRENT USER registry values have a higher priority than the
registry values under HKEY LOCAL MACHINE.

6.2 System-Specific Color Settings (Options Dialog)

For SAP systems with a kernel in which the note 1617682#% is built in, it is possible to set a different SAP
Signature, Blue Crystal or Belize color for different clients of this SAP system:

e System-specific Rollout

To roll out the color setting for a specific SAP system, create the following registry key and values under

HKEY_LOCAL_MACHINEZ
[HKEY LOCAL MACHINE\SOFTWARE\SAP\General\Appearance\Systems\<SID>]

[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance\Systems\<SID>]

(on 64-Bit OS)
(replace s1ID by the sytem ID of your SAP system)

ThemeName [REG_SZ] (Possible values for SAP Signature: SAP Gold, SAP Green, SAP Purple, SAP

Red Oor SAP Signature Default)

ThemeNameBC [REG_SZ](VaueSfOFBhKECryStﬂZSAP BC Gold, SAP BC Green, SAP BC Purple,

SAP BC Red Or BlueCrystal for the default)
ThemeNameBelize [REG_Sz] (values for Belize: Belize Gold, Belize Green, Belize Purple,
Belize Redor Belize for the default)

ThemeNameQuartz [REG_SZ] (values for Quartz: Quartz Gold, Quartz Green, Quartz Purple,

Quartz Red or Quartz for the default)

ThemeNameQuartzDark [REG_SZ] (values for Quartz: Quartz Dark Gold, Quartz Dark Green,

Quartz Dark Purple, Quartz Dark RedOr Quartz Dark for the default)
e Client-specific Rollout

To roll out the SAP Signature color setting for a specific client in a SAP system create the following registry

key and values under HKEY LOCAL MACHINE:

[HKEY LOCAL MACHINE\SOFTWARE\SAP\General\Appearance\Systems\<SID>\<Client>]
[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance\Systems\<SID>
\<Client>] (on 64-Bit OS)

(replace sID by the System ID of your SAP system and replace client by the actual client number, for
example 100)

ThemeName [REG_SZz] (Possible values: SAP Gold, SAP Green, SAP Purple, SAP Red Or SAP
Signature Default)

ThemeNameBC [REG_Sz] (Possible values for Blue Crystal: SAP BC Gold, SAP BC Green, SAP BC
Purple, SAP BC Red or BlueCrystal for the default)

SAP GUI Administration
Setting Theme Color PUBLIC

15


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1617682

ThemeNameBelize [REG_SZz] (values for Belize: Belize Gold, Belize Green, Belize Purple
Belize RedorBelize for the default)

® ThemeNameQuartz [REG_SZ] (values for Quartz: Quartz Gold, Quartz Green, Quartz Purple
Quartz Red or Quartz for the default)
ThemeNameQuartzDark [REG_Sz] (values for Quartz: Quartz Dark Gold, Quartz Dark Green,
Quartz Dark Purple, Quartz Dark Redor Quartz Dark for the default)

The color settings for SAP systems (and/or clients in system) can also be changed via the SAP GUI Options
dialog on the page |» Visual Design ¥ Colors in System 3 (if the active theme is one of SAP Signature Theme,
Blue Crystal Theme , Belize Theme or Quartz Theme). When logged on to the respective SAP system/client, the
SAP GUI Options dialog saves the settings under the same registry keys and values, but under

HKEY CURRENT USER. The HKEY CURRENT USER registry values have a higher priority than the registry
values under HKEY LOCAL MACHINE.

The registry key and values under
[HKEY LOCAL MACHINE\SOFTWARE\SAP\General\Appearance\Systems]

[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance\Systems] (on64-Bit
0S)

are copied at startup of SAP Logon (SAP GUI) from HKEY LOCAL MACHINE to HKEY CURRENT USER
without overwriting existing values.

6.3 System-Specific Color Settings (System Profile
Parameter)

A SAP Signature color can be defined in the SAP system via the system profile parameter sapgui/

signature color.

Note 1640960 describes this system parameter and how to set it. This note must be part of the kernel in
order to support this feature.

For Blue Crystal Theme and Belize Theme the same functionality is available as of SAP GUI for Windows 7.60.
For Quartz Theme and Quartz Dark Theme the same functionality is available as of SAP GUI for Windows 7.70.
To activate the color settings a new profile parameter sapgui/system color isrequired.

See SAP Note 2571622 for more information on the prerequisites for SAP_BASIS and SAP Kernel.

The new profile parameter sapgui/system color can also be used to activate the color settings for SAP
Signature Theme.

There are several ways to overwrite a color setting defined by the SAP system with a local configuration:

® You can ignore the color defined by the SAP system parameter for all systems, if you create the following
registry value:
[HKEY LOCAL MACHINE\SOFTWARE\SAP\General\Appearance] [HKEY LOCAL MACHINE
\SOFTWARE\Wow6432Node\SAP\General \Appearance]
(on 64-Bit OS)
SignatureSystemDependentColorsActive [REG DWORD] = 0

SAP GUI Administration
16 PUBLIC Setting Theme Color


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/Note 1640960
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2571622

i Note

This registry value also has effect for Blue Crystal, Belize, Quartz and Quartz Dark Theme.

The setting can also be changed via the SAP GUI Options dialog on page | Visual Design  Color

Settings . The checkbox Accept default color by SAP system enables/disables the application of the color
defined by the SAP system. The SAP GUI Options dialog saves the setting under the same registry key and
value but under HKEY CURRENT USER. The HKEY CURRENT USER registry values have a higher priority
than the registry values under HKEY LOCAL MACHINE.

You can ignore the color defined by the SAP system for only some specific SAP systems or clients in an
SAP system. This can be achieved if one defines another color for this SAP system or client locally on the
machine like this is described in sectionSystem-Specific Color Settings (Options Dialog) [page 15] of this
guide.

6.4 Priority of the Different Color Configurations

For SAP Logon, only the locally definied default color is used as described in section SAP GUI Default Color
[page 14] of this guide.

For a SAP GUI session, several settings will be checked:

1

First of all, the locally defined color for the specific client in a specific SAP system will be checked and
applied (see section System-Specific Color Settings (Options Dialog) [page 15]).

If the client setting is not defined, the locally defined color for the specific SAP system will be checked and
applied (see section System-Specific Color Settings (Options Dialog) [page 15])

If this is also not defined and the default color defined by a SAP system is set to be accepted (otherwise
this step will be omitted), the color defined by the SAP system will be checked and applied (see section
System-Specific Color Settings (System Profile Parameter) [page 16]).

If the profile parameter is not set, the locally defined SAP GUI default color will be checked and applied
(see section SAP GUI Default Color [page 14]).

If the SAP GUI default color is not defined, the SAP GUI session will be shown in the SAP GUI default color.
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7 Registry Values and Read-Only Feature of
SAP GUI Options Dialog

In this chapter, the registry values are listed which are used to customize the behavior, appearance, and
functionality of SAP GUI via the SAP GUI Options dialog.

In addition, this chapter shows how to define default values for specific SAP GUI settings and how to deactivate
some settings in the SAP GUI Options dialog. However, it does not describe the functionality behind the registry
values. For this purpose, you have to refer to the SAP GUI end user guide. For the security settings, refer to the
Security Guide. You can find all SAP GUI for Windows Guides on the corresponding product page.

i Note

For most registry values, SAP GUI will first access HKEY CURRENT USER and, if this registry value doesn't
exist, then HKEY LOCAL MACHINE will be accessed.

If under HKEY LOCAL MACHINE this registry value also does not exist, then the SAP GUI default value will
be applied. In this document, only exceptions to this approach will be mentioned.

Registry keys for restricting specific settings in the SAP GUI Options dialog are only located under
HKEY LOCAL MACHINE.

i Note

Also note that in the following registry value descriptions “” stands for 'no value' or 'empty field'.

i Note

And finally note, the registry values mentioned in this documentation are described for 64bit operating
systems. When you use a 32bit operating system, then make sure that in case of HKEY_LOCAL_MACHINE
the values are not written in the path with WOW6432Node.

Example:
64bit: [HKEY LOCAL MACHINE\SOFTWARE\WOW6432Node\SAP\General]

32bit: [HKEY LOCAL MACHINE\SOFTWARE\SAP\General]

71 Read-Only Feature of the SAP GUI Options Dialog

It is possible to restrict the usage of the SAP GUI Options dialog by setting some or all of its options read-only.
Setting the options read-only in the Ul does not change the reading priority of the registry values. When options
have been set read-only, the user can no longer change these settings via the SAP GUI Options dialog.

There are three possibilities to set options in SAP GUI Options dialog read-only.
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1. Setting all options read-only
To set all options in the SAP GUI Options dialog read-only, create the following registry values:
[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\General]
AllOptionsReadOnly (REG_DWORD) =1
CurRegValReadOnlyActive (REG_DWORD) =0
Result: In the title bar of the SAP GUI Options dialog, the text [read-only] will be added.
2. Setting most options read-only and exceptions changeable
To activate the feature that most options in the SAP GUI Options dialog should be read-only and only a few
exceptions should remain changeable create the following registry values:
[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\General]
AllOptionsReadOnly (REG_DWORD) =1
CurRegValReadOnlyActive (REG_DWORD) = 1
Result: In the title bar of the SAP GUI Options dialog, the text [partly read-only] will be added and all options
of the SAP GUI Options dialog are read-only. You can now make some special options changeable again by
using the following approach:
1. You know the registry value name of the option, for example, SelectedTheme.
2. You know the registry key where the registry value is located, for example, [HKEY CURRENT USER
\Software\SAP\General\Appearance].

3. Under HKEY LOCAL MACHINE, you now add _ReadOnly to the registry value name, for example,
SelectedTheme_ReadOnly, and create the REG_DWORD registry value under the “same” registry key
as the original registry key. For example:

[HKEY LOCAL MACHINE\Wow6432Node\Software\SAP\General\Appearance]

4. Setthe ReadOnly REG_DWORD registry value to 0, so that the option belonging to this registry value
is again changeable in the SAP GUI Options dialog, for example SelectedTheme ReadOnly
(REG_DWORD)=0.

3. To activate the feature that most options in the SAP GUI Options dialog should remain changeable and only

a few exceptions should be read-only create the following registry values:
[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\General]

AllOptionsReadOnly (REG_DWORD) =0

CurRegValReadOnlyActive (REG_DWORD) =1

Result: In the title bar of the SAP GUI Options dialog, the text “[partly read-only]” will be added and all
options of the SAP GUI Options dialog remain editable.

To make specific options read-only, proceed as follows:

1. You know the registry value name of the option, for example AnimatedFocus.

2. You know the registry key, where the registry value is located, for example, [HKEY CURRENT USER
\Software\SAP\General\Appearance].

3. Under HKEY LOCAL MACHINE, you now add _ReadOnly to the registry value name, for example,
AnimatedFocus_ReadOnly, and create the REG_DWORD registry value under the “same” registry key
as the original registry key. For example:

[HKEY LOCAL MACHINE\Wow6432Node\Software\SAP\General\Appearance]

4. Setthe _ReadOnly REG_DWORD registry value to 1, so that the option belonging to this registry value

will be set read-only in the SAP GUI Options dialog, for example, AnimatedFocus_ReadOnly
(REG_DWORD) = 1.
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7.2 Registry Values Used in the SAP GUI Options Dialog

The following sub-chapters describe the registry values that belong to settings in the SAP GUI Options dialog.

i Note

If nothing is written about a special handling for the read-only feature, then the particular option can be
separately set read-only as described above.

i Note

wn

Also note that in the following registry value descriptions “” stands for 'no value' or 'empty field'.

7.2.1 Theme Settings Page

— SAP GUI Options - SAP Logon X
Find a setting | Visual Design
~ Visual Design Theme Selection
I—ThemeSettings—l
IFontSenMgs ' Select Theme: \OuanzTheme ~
Branding [v] Activate animated focus
Color Settings [[] Multi-monitor scaling awareness
> Interaction Design [] Move main menu to 'More' button
> Accessibility & Scripting [Vl Activate SAP Fiori features
> Multilingual Settings [] Show toolbar buttons with text
> Local Data
> Traces
> Security
> SAP Logon Options
> Front-End Print
Restore & Cleanup
System Information
“ Cancel Apply Help
Registry Values

Select Theme

[HKEY CURRENT USER\Software\SAP\General\Appearance]

SelectedTheme (REG_DWORD) [Default: 2048 = Quartz Theme or 16384 = Quartz Dark Theme ]
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Which of the two themes is used, depends on whether the Dark mode for applications is activated in Windows
or not.

Possible Values (Invalid Value - Quartz/Quartz Dark Themes will be used):
(0x1) (Dec=1) = SAP Signature Theme

(0x2) (Dec=2) = Signature High Contrast Black Theme
(0x20) (Dec=32) = Classic Theme

(0x40) (Dec=64) = Corbu Theme

(0x80) (Dec=128) = Blue Crystal

(0x100) (Dec=256) = Belize Theme

(0x200) (Dec=512) = Belize High Contrast Black Theme
(0x400) (Dec=1024) = Belize High Contrast White Theme
(0x800) (Dec=2048) = Quartz Theme

(0x1000) (Dec=4096) = Quartz High Contrast Black Theme
(0x2000) (Dec=8192) = Quartz High Contrast White Theme

(0x4000) (Dec=16384) = Quartz Dark Theme

Restricting entries in “Select Theme” combobox

[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance\Themes]
SelectableThemes (REG_DWORD) [Default: 0x7F] (for restricting entries in “Theme” combobox):
(0x1) (Dec=1) = SAP Signature Theme

(0x2) (Dec=2) = Signature High Contrast Black Theme

(0x20) (Dec=32) = Classic Theme

(0x40) (Dec=64) = Corbu Theme

(0x80) (Dec=128) =Blue Crystal

(0x100) (Dec=256) = Belize Theme

(0x200) (Dec=512) = Belize High Contrast Black Theme

(0x400) (Dec=1024) = Belize High Contrast White Theme

(0x800) (Dec=2048) = Quartz Theme

(0x1000) (Dec=4096) = Quartz High Contrast Black Theme

(0x2000) (Dec=8192) = Quartz High Contrast White Theme

(0x4000) (Dec=16384) = Quartz Dark Theme

i Note

Enjoy, Tradeshow and Streamline are not supported anymore as of SAP GUI for Windows 7.60.
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The values for Tradeshow and Streamline are treated as invalid entries and the default theme is used
instead. The value for Enjoy was re-used for SAP Signature High Contrast Black (0x2). Therefore, local
settings may require an adjustment when upgrading.

Example: In order to allow the selection of Blue Crystal and Corbu Theme sum up the corresponding values
0x80 and 0x40 - 0xCO or in Decimal: 64 and 128 -> 192

Please, remember to change the values in Hex format or convert the Hex values to Decimal values and then
sum up the Decimal values. In order to allow the selection of “SAP Signature Theme” and “Corbu Theme" sum
up the corresponding values 0x1 and 0x40 —» 0x41.

Activate animated focus (not available for Classic theme)

[HKEY CURRENT USER\Software\SAP\General\Appearance]

AnimatedFocus (REG_DWORD) [Default: 1] {O =inactive; 1 = active}

Multi-monitor scaling awareness (only available for Belize and Quartz Themes)

[HKEY CURRENT USER\Software\SAP\General\Appearance]

MultiMonitorDpiAwareness (REG_DWORD) [Default: 0]{O = inactive; 1 = active}

i Note

This function is only available as of Microsoft Windows 10 Version 1803 and corresponding Server/0OS-
Versions.

Move main menu to ,More’ button (only available for Belize and Quartz Themes)

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

MainMenuInMoreButton (REG_DWORD) [Default: 0] {O = inactive; 1 = active}

Activate SAP Fiori features (only available for Belize and Quartz Themes)

[HKEY CURRENT USER\Software\SAP\General\Appearance]

ActivateFioriFeatures (REG_DWORD) [Default: 1] {O = inactive; 1 = active}

Show toolbar buttons with text (only available for Belize and Quartz Themes)

[HKEY CURRENT USER\Software\SAP\General\Appearance]

FioriToolbarButtonsWithIcons (REG_DWORD) [Default: 1]{0 =inactive - this means buttons are
displayed with texts only; 1 = active — this means buttons are displayed with icons}

i Note

This option can only be used when the SAP Fiori Features are activated.

i Note

In previous releases of SAP GUI for Windows, the respective option in the SAP GUI options dialog was called
Show toolbar buttons with icons. In release 7.70, it was decided to reverse this option due to a huge demand
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for buttons with icons and to change the default value of the option as well. However, since the registry
value was already in use and was intended to keep working beyond an upgrade, it was decided to keep the
name of the registry value. Therefore, the name of the option and the name of the registry value do not
match anymore.

Fallback
i Note

As of SAP GUI for Windows 7.70, the usage of fallback themes is no longer supported. When an SAP system
does not support the SAP Fiori Features, you can still use any of the available SAP GUI themes. Thus, a
fallback theme is no longer needed.

Show shadow border (only SAP Signature and Corbu Theme)

[HKEY CURRENT USER\Software\SAP\General\Appearance]

ShowShadowBorder (REG_DWORD) [Default: 1]{0 =inactive; 1=active}

Corbu style icons (only SAP Signature Theme)

[HKEY CURRENT USER\Software\SAP\General\Appearance]

CorbuIcon (REG_DWORD) [Default: 1]{0 = inactive; 1 = active}

7.2.2 Font Setting Page

= SAP GUI Options - SAP Logon X
| Find a setting | Visual Design
~ Visual Design General Font Settings

Theme Settings
:— Font Settings—:

Branding

Color Settings

[] Select proportional font

[] Only fonts of the same character set

[v] Use default font settings for SAP Fiori themes

> Interaction Design ’
o & o Monospaced Font Settings
> Accessibility & Scripting ) ) ‘ ) ) o
> Multilingual Settings Font is used for input fields and lists where character-align formatting is used.
> Local Data 72 Monospace Select
> Traces
> Security Proportional Font Settings
> SAP Logon Options Font is used for label and description texts.
> Front-End Print 72 Select

Restore & Cleanup
System Information
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Registry Values
Select proportional font
[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

KanjiFontDialogProp (REG_DWORD) [Default: 0] {O = inactive; 1 = active}

Only fonts of the same character set

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

KanjiFontDialogScript (REG_DWORD) [Default: 0] {O = inactive; 1 = active}

Use default font settings for SAP Fiori themes

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

UseBelizeFontSettings (REG_DWORD) [Default: 1]{0 = inactive; 1 = active}

Monospaced Font Settings

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

i Note

For SAP Fiori Visual Themes (Belize and newer themes) partly other registry values have to be used as
stated below.

Font.Height (REG_DWORD) [Default: 15]

Font.Width (REG_DWORD) [Default: 0]

Font.CharSet (REG_DWORD) [Default: set system charset or 0]

Font.Facename (REG_SZ) [Default: depends on the set charset]

Fiori Visual Theme (Belize and higher):
Fiori3.Font.Height (REG_DWORD) [Default: Oxfffffff2 == -14]
Fiori3.Font.Width (REG_DWORD) [Default: 0]

Fiori3.Font.Facename (REG_SZz) [Default: depends on the set charset]

i Note

The registry values Fiori3.Font.* and Fiori3.Prop.* have been introduced in release 7.70 and replace the old
values Belize.Font* / Belize.Font* (in SAP GUI for Windows 7.50) and Fiori.Font / Fiori.Prop* (in SAP GUI for
Windows 7.60) . This was required due to a changed default font setting for the Belize and Quartz themes in
release 7.70. As of release 7.70 the default monospaced font is 72 monospace.

i Note

Special handling for read-only feature:

Setting most options changeable and only some exceptions read-only
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Itis enough to set one of the fixed font registry values read-only, so that the Select button will be disabled.
Setting most options read-only and exceptions changeable:

For all the fixed font registry values a corresponding *_ReadOnly REG_DWORD registry value must be
created and set to 0, so that the Select button will be enabled.

Proportional Font Settings

iNote
For SAP Fiori Visual Theme (Belize and newer themes) partly other registry values have to be used as
stated below.
[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]
Prop.Height (REG_DWORD) [Default: 15]
Prop.Width (REG_DWORD) [Default: 0]
Prop.CharSet (REG_DWORD) [Default: set system charset or 0]

Prop.Facename (REG_SZ) [Default: depends on the set charset]

Fiori Visual Theme (Belize and higher):
Fiori3.Prop.Height (REG_DWORD) [Default: Oxf££££££2 == -14]
Fiori3.Prop.Width (REG_DWORD) [Default: 0]

Fiori3.Prop.Facename (REG_Sz) [Default: depends on the set charset]

i Note

The registry values Fiori3.Font.* and Fiori3.Prop.* have been introduced in release 7.70 and replace the old
values Belize.Font* / Belize.Font* (in SAP GUI for Windows 7.50) and Fiori.Font / Fiori.Prop* (in SAP GUI for
Windows 7.60) . This was required due to a changed default font setting for the Belize and Quartz themes in
release 7.70. As of release 7.70 the default monospaced font is 72 monospace.

i Note
Special handling for read-only feature:
Setting most options changeable and only some exceptions read-only:

It is enough to set one of the proportional font registry values read-only, so that the Select button will be
disabled.

Setting most options read-only and exceptions changeable:

For all the proportional font registry values a corresponding *_ReadOnly” REG_DWORD registry value must
be created and set to 0, so that the Select button will be enabled.
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7.2.3 Branding Page

= SAP GUI Options - SAP Logon X
| Find a setting | Visual Design
~ Visual Design Branding
Theme S.ettings [T] Activate branding in title bar of SAP GUI sessions
Font Settings ) )
= Branding—l Branding Image to Display:
I Color Setltings ‘ ‘ [ Select J
> Interaction Design Ty
> Accessibility & Scripting .
> Local Data
> Traces
> Security
~  SAP Logon Options
General

Configuration Files
> Front End Print
Restore & Cleanup
System Information

Registry Values

Activate Branding

[HKEY CURRENT USER\Software\SAP\General\Appearance]

UseBrandingImage (REG_DWORD) [Default: 0] {O = inactive; 1 = active}

Path to branding image

[HKEY CURRENT USER\Software\SAP\General\Appearance]
BrandingImage (REG_SZ) [Default: “"] {valid path to a valid image file}

By default, this page is read-only. To set this page changeable, create the following registry values (it is not
necessary to activate the read-only feature for setting this page changeable):

[HKEY CURRENT USER\Software\SAP\General\Appearance]
UseBrandingImage ReadOnly (REG_DWORD) =0
BrandingImage ReadOnly (REG_DWORD) =0

You find more information on branding in section Using Branding [page 11] in this guide.
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7.2.4 Define Custom Colors (SAP Signature)

SAP GUI Options - SAP Logon 4

Search: ! !

* [£= Visual Design | Define Custom SAP Signature Colors

* [2) Theme Settings T i

. Font Settings SAP Gold

: . SAP Green
o Branding
= - SAP Purple —

o Define Custom Colors, SAP Red ==

. Color Settings SAP Signature Default = = I —
» [T Interaction Design a—) :
» [ Accessibiity & Scripting i |
» [0 Muttiingual Settings
» [T Local Data l B I Hue shift value [Dearees]:
* [ Traces
» [ Security l Delete I | -135] D
» [Osap Logon Options
» [ Front End Print
: Restore & Cleanup Colors defined by SAP and your administrator cannot be deleted and
= System Information overwritten

l 0] 4 I l Cancel ‘ ‘ Apply ‘ l Help
i Note

This dialog is only available when having chosen SAP Signature Theme.

Registry Values

Define Custom SAP Signature Colors

[HKEY CURRENT USER\Software\SAP\General\Appearance\Customer Colors\Custom Color 1]

Hue (REG_ DWORD) [Default: no default - value must exist] { [0;360]: add 180 to the value which you see in
the Options Dialog e.g.: =20 — calculated decimal value for Hue registry value 160 }

Registry key name Custom Color 1 isthe name of the color, which can be selected as SAP Signature Color
on the pages Color Settings/Colors in Systems. Names for custom SAP Signature colors are freely selectable
with the exception of color names which are already defined by SAP. The Options dialog prevents the creation
of such values (if you create the registry key/value on your own, make sure your provide correct names for the
color and correct values for the hue shift value).

If the Hue registry value does not exist, then it will not be listed in the Options dialog and has no effect. If a value
is bigger than 360, it will be set to 360 (180 in the Options dialog).

If there is a registry key under HKLM, HKCU is not checked anymore and this entry cannot be changed or
deleted anymore in the Options dialog. This is also the case for the colors predefined by SAP.
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i Note

Special handling for read-only feature:

Itis only possible to set the complete page read-only/changeable by creating the following registry value:

[HKEY CURRENT USER\Software\SAP\General\Appearance\Customer Colors]

CustomColors_ReadOnly (REG_DWORD)

7.2.5 Color Settings Page

This section describes the Color Settings Page for the following SAP GUI themes: SAP Signature, Blue Crystal,

Belize, Quartz and Quartz Dark.

7.2.5.1

Color Settings for Signature Theme

SAP GUI Options - SAP Logon x

* [ Visual Design
0 Theme Settings
. Font Settings
0 Branding
5 Define Custom Colors
:
» [ Interaction Design
* [ Accessibility & Scripting
+ [0 Mutiingual Settings
* [ Local Data
» [ Traces
(| Security
+ [ SAP Internal
» [sap Logon Options
* [ Front End Print
g Restore & Cleanup
v System Information

| SAP Theme Default Color

Search: !

SAP Gold
SAP Green
SAP Purple
SAP Red

ignature Default

|| Accept default color defined by SAP system

oK H Cancel I ‘

Apply H Help
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Registry Values

SAP Theme Default Color

[HKEY CURRENT USER\Software\SAP\General\Appearance]
SignatureDefaultColor (REG_SZ) [Default: “"]

Possible values:

SAP Gold

SAP Green

SAP Purple

SAP Red

SAP Signature Default;in case of an empty string, missing registry value, or unvalid value, the SAP

Signature default is used.

Accept default color defined by SAP systems
[HKEY CURRENT USER\Software\SAP\General\Appearance]

SignatureSystemDependentColorsActive (REG_DWORD) [Default: 1]{0 = inactive; 1 = active}

7.25.2 Color Settings for Blue Crystal Theme

Logon

Search:

w Oy Wisual Design SAP Theme Default Color

= 2] Theme Settings

SAP BC Gold

= [2] Font Settings SAP BC Grean
* [2] Branding S4P BC Purple =
SAP BC Red

Color Settings
Interaction Design
Accessibility & Scripting
Multilingual Settings
Local Data

< sccept default color defined by SAP system
Traces

Security
SAP Internal
hd SAP Logon Options
= 2] General
Local Configuration Files
Server Configuration Files
> Front End Print
= [21 Restore & Ceanup
= [B System Information

L L L

Change takes effect for new sessions and after restart of SAP Logon (Pad),

i,

| oK | | Cancel | | Anply | | Heln
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Registry Values

SAP Theme Default Color

[HKEY CURRENT USER\Software\SAP\General\Appearance]

BlueCrystalDefaultColor (REG_SZ) [Default: “"]

Possible values:

SAP BC Gold

SAP BC Green

SAP BC Purple

SAP BC Red

Blue Crystal;in case of an empty string, missing registry value, or unvalid value, the BlueCrystal Theme is

used.

Accept default color defined by SAP systems

[HKEY CURRENT USER\Software\SAP\General\Appearance]

SignatureSystemDependentColorsActive (REG_DWORD) [Default: 1] {0 =inactive; 1 = active}

i Note

This registry value also has effect for Blue Crystal Theme and Belize Theme.
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7.2.5.3 Color Settings for Belize

= SAP GUI Options - SAP Logon

Find a setting Visual Design
~ Visual Design SAP Theme Default Color
Theme Settings
Font Settings Belize Gold
. Belize Green
. Branding } Belize Purple
_ Color SettingsJ Belize Red
> Interaction Design
> Accessibility & Scripting
> Multilingual Settings i
v| Accept default color defined by SAP system
> Local Data
> Traces
> Security
> SAP Logon Options
> Front End Print

Restore & Cleanup
System Information

oK Cancel Help

Registry Values

SAP Theme Default Color

[HKEY CURRENT USER\Software\SAP\General\Appearance]

BelizeDefaultColor (REG_SZ) [Default: “"]

Possible values:
Belize Gold

Belize Green
Belize Purple

Belize Red

Belize; in case of an empty string, missing registry value, or unvalid value, the Belize is used.

Accept default color defined by SAP systems

[HKEY CURRENT USER\Software\SAP\General\Appearance]

SignatureSystemDependentColorsActive (REG_DWORD) [Default: 1]{0 =inactive; 1 = active}

SAP GUI Administration
Registry Values and Read-Only Feature of SAP GUI Options Dialog PUBLIC

31



i Note

This registry value also has effect for Blue Crystal Theme and Belize Theme.

7.2.5.4 Color Settings for Quartz

= SAP GUI Options - SAP Logon X
| Find a setting | Visual Design
v Visual Design SAP Theme Default Color
Theme Settings Quartz
Font Settings Quartz Gold
i Quartz Green
- Branding . Quartz Purple
. Color Settings: Quartz Red
> Interaction Design
> Accessibility & Scripting
> Multilingual Settings )
Accept default color defined by SAP system
> Local Data
> Traces
> Security
~  SAP Logon Qptions
General

Configuration Files
> Front End Print
Restore & Cleanup
System Information

Registry Values

SAP Theme Default Color

[HKEY CURRENT USER\Software\SAP\General\Appearance]

QuartzDefaultColor (REG_SZ) [Default: “"]

Possible values:

Quartz Gold
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Quartz Green
Quartz Purple
Quartz Red

Quartz; in case of an empty string, missing registry value, or unvalid value, the Quartz is used.

Accept default color defined by SAP systems
[HKEY CURRENT USER\Software\SAP\General\Appearance]

SignatureSystemDependentColorsActive (REG_DWORD) [Default: 1]{0 = inactive; 1 = active}

i Note

This registry value also has effect for Blue Crystal Theme, Belize and Quartz Theme.

7.2.5.5 Color Settings for Quartz Dark

Registry Values

SAP Theme Default Color
[HKEY CURRENT USER\Software\SAP\General\Appearance]

QuartzDarkDefaultColor (REG_SZ) [Default: “"]

Possible values:
Quartz Dark Gold
Quartz Dark Green
Quartz Dark Purple
Quartz Dark Red

Quartz Dark;in case of an empty string, missing registry value, or unvalid value, the Quartz is used.

Accept default color defined by SAP systems
[HKEY CURRENT USER\Software\SAP\General\Appearance]

SignatureSystemDependentColorsActive (REG_DWORD) [Default: 1]{0 =inactive; 1= active}

i Note

This registry value also has effect for Blue Crystal, Belize and Quartz/Quartz themes.
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7.2.6 Colors in System Page

This section describes the Colors in System Page for the following SAP GUI themes: SAP Signature, Blue
Crystal and Belize. This page is only displayed when the SAP GUI options dialog is started from a SAP GUI
session and the client-specific settings are only available when you are logged on (and thus the client is
determined).

7.2.6.1 Colors in System Page for Signature Theme

ST Cptions

* = Wisual Design | Color Setting for SAP System
o Therme Settings Default configuration STy A — —
* [2) Font Settings gig gﬂhj
; ) reen
EEETE SAP Purple
+ [2] Define Custom Calors SAP Red
~ & Color Settings SAP Signature Default

g Colors in System T —— e
* [ Interaction Design
¥ [ Accessibility & Scripting
v [ muitilingual Settings
» [T Local Data

Color Settings for SAP System Client 000

» [ Traces Systern setting -
v [0 Security 5ald
v [ 58P Internal SAP Green
) S&P Purple -
* [T Front End Print SAP Red
- Restore & Cleanup SAP Signature Default

» [E1 System Information T

oK I I Cancel ‘ | Apply | l Help

Registry Values

Color Setting for SAP system SID
[HKEY CURRENT USER\Software\SAP\General\Appearance\Systems\SID]

ThemeName (REG_SZ) [Default: registry key and registry value do not exist] {SID in the registry key is your
SAP System ID}
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Possible values:

Value does not exist or is empty —» Default configuration or SAP system configuration
SAP Gold

SAP Green

SAP Purple

SAP Red

SAP Signature Default

Color Settings for SAP system SID client <number>
(only possible in SAP Signature Theme and if the SAP system supports this feature)

[HKEY CURRENT USER\Software\SAP\General\Appearance\Systems\SID\000]

ThemeName (REG_SZ) [Default: registry key and registry value do not exist] {SID in the registry key is your
SAP System ID and <number> is the current client in the SAP system, for example 000}

Possible values: the same like for “Color Setting for SAP system SID”

You find more information for system/client-dependent color theming in section Setting SAP Signature Theme
Color.

i Note

Special handling for read-only feature:

Itis only possible to set the complete page read-only/changeable by creating the following registry value:
[HKEY LOCAL MACHINE\Wow6432Node\Software\SAP\General\Appearance\Systems]

ColorsSystemSpecific_ReadOnly (REG_DWORD)
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7.2.6.2

~  Wisual Design

= [B] Theme Settings

= [2] Font Settings

= [5) Branding

~ [2) Color Settings
= i[E] cColors in Systern
Interaction Design
Accessihility & Scripting
Multilingual Settings
Local Data

»
»

¥

»

» [0 Traces
» [0 Security
»

»

Colors in System Page for Blue Crystal Theme

Search:

Color Setting for SAP Systemn

Default configuration W cemgso

uogL AT e

BlueCrystal
SAP BC Gold
SAP BC Green
SR BC Purple
SAP BC Red

Color Settings for SAP System Client 000

erm setting
BlueCrystal

SAP BC Gold
SAP Internal SAP BC Green
Front End Brint SAP BC Purple
| rrentEns N S4P BC Red
= [2] Restare & Cleanup e T —
= [2 Swstem Information
QK | | Cancel | | Anply | | Help
Registry Values

Color Setting for SAP system SID

[HKEY CURRENT USER\Software\SAP\General\Appearance\Systems\SID]

ThemeNameBC (REG_Sz) [Default: registry key and registry value do not exist] {SID in the registry key is your

SAP System ID}

Possible values:

Value does not exist or is empty — Default configuration or SAP system configuration

SAP BC Gold
SAP BC Green
SAP BC Purple
SAP BC Red

Blue Crystal
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Color Settings for SAP system SID client <number>
(only possible if the SAP system supports this feature)
[HKEY CURRENT USER\Software\SAP\General\Appearance\Systems\SID\000]

ThemeNameBC (REG_Sz) [Default: registry key and registry value do not exist] {SID in the registry key is your
SAP System ID and <number> is the current client in the SAP system, for example 000}

Possible values: the same like for Color Setting for SAP system SID
i Note
Special handling for read-only feature:

Itis only possible to set the complete page read-only/changeable by creating the following registry value:
[HKEY LOCAL MACHINE\Wow6432Node\Software\SAP\General\Appearance\Systems]

ColorsSystemSpecific_ReadOnly (REG_DWORD)

7.2.6.3 Colors in System Page for Belize Theme

SAP GUI Options X
~ Wisual Design Color Setting for SAP System
Theme Settings Default configuration —
Font Settings g:t:;: Gold = —
Branding Belize Green
Belize Purple

~ Color Settings

Colors in System

Belize Red

» Interaction Design
> Accessibility & Scripting ) )
Color Settings for SAP System Client 000
> Multilingual Settings .
Systemseting B
» Local Data Belise =
» Traces Belize Gold T
. Belize Green
> Security Belize Purple
> SAP Internal Belize Red
»

Front End Print

Restore & Cleanup

System Information

oK Cancel Help
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Registry Values

Color Setting for SAP system SID

[HKEY CURRENT USER\Software\SAP\General\Appearance\Systems\SID]

ThemeNameBelize (REG_SZ) [Default: registry key and registry value do not exist] {SID in the registry key is
your SAP System ID}

Possible values:

Value does not exist or is empty - Default configuration (Belize) or SAP system configuration is used

Belize Gold

Belize Green

Belize Purple

Belize Red

Belize

Color Settings for SAP system SID client <number>
(only possible if the SAP system supports this feature)

[HKEY CURRENT USER\Software\SAP\General\Appearance\Systems\SID\000]

ThemeNameBelize (REG_Sz) [Default: registry key and registry value do not exist] {SID in the registry key is
your SAP System ID and <number> is the current client in the SAP system, for example 000}

Possible values: the same like for Color Setting for SAP system SID

i Note

Special handling for read-only feature:

It is only possible to set the complete page read-only/changeable by creating the following registry value:
[HKEY LOCAL MACHINE\Wow6432Node\Software\SAP\General\Appearance\Systems]

ColorsSystemSpecific_ReadOnly (REG_DWORD)
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7.2.6.4 Colors in System Page for Quartz Theme

= SAP GUI Options - YI3 X
| Find a setting | Visual Design
~ Visual Design Color Setting for SAP System YI3
Theme Settings Default configuration ]
Font Settings Quartz
i Quartz Gold e - S
Branding Quartz Green
~ Color Settings Quartz Purple
o . 1 Quartz Red
. Colors in System
> Interaction Design
> Accessibility & Scripting
> Multilingual Settings Color Settings for SAP System Y13; Client 000
> Local Data I ——
Quartz
’ Tracef; Quartz Gold -
> Security Quartz Green
; Quartz Purple
> Front End Print Quartz Red ‘
Restore & Cleanup
System Information
Registry Values

Color Setting for SAP system SID

[HKEY CURRENT USER\Software\SAP\General\Appearance\Systems\SID]

ThemeNameQuartz (REG_Sz) [Default: registry key and registry value do not exist] {SID in the registry key is
your SAP System ID}

Possible values:

Value does not exist or is empty — Default configuration (Quartz) or SAP system configuration is used

Quartz Gold

Quartz Green

Quartz Purple

Quartz Red

Quartz

Color Settings for SAP system SID client <number>

(only possible if the SAP system supports this feature)
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[HKEY CURRENT USER\Software\SAP\General\Appearance\Systems\SID\000]

ThemeNameQuartz (REG_SZ) [Default: registry key and registry value do not exist] {SID in the registry key is
your SAP System ID and <number> is the current client in the SAP system, for example 000}

Possible values: the same like for Color Setting for SAP system SID

i Note

Special handling for read-only feature:

Itis only possible to set the complete page read-only/changeable by creating the following registry value:
[HKEY LOCAL MACHINE\Wow6432Node\Software\SAP\General\Appearance\Systems]

ColorsSystemSpecific_ReadOnly (REG_DWORD)

7.2.6.5 Colors in System Page for Quartz Dark Theme

Color Setting for SAP system SID

[HKEY CURRENT USER\Software\SAP\General\Appearance\Systems\SID]

ThemeNameQuartzDark (REG_Sz) [Default: registry key and registry value do not exist] {SID in the registry
key is your SAP System ID}

Possible values:

Value does not exist or is empty —» Default configuration (Quartz Dark) or SAP system configuration is used
Quartz Dark Gold

Quartz Dark Green

Quartz Dark Purple

Quartz Dark Red

Quartz Dark

Color Settings for SAP system SID client <number>

(only possible if the SAP system supports this feature)
[HKEY CURRENT USER\Software\SAP\General\Appearance\Systems\SID\000]

ThemeNameQuartz (REG_Sz) [Default: registry key and registry value do not exist] {SID in the registry key is
your SAP System ID and <number> is the current client in the SAP system, for example 000}

Possible values: the same like for Color Setting for SAP system SID

i Note
Special handling for read-only feature:
Itis only possible to set the complete page read-only/changeable by creating the following registry value:

[HKEY LOCAL MACHINE\Wow6432Node\Software\SAP\General\Appearance\Systems]
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I ColorsSystemSpecific_ReadOnly (REG_DWORD)

7.2.7 Classic Design - Options Page

'L SAP GUI Options - SAP Logon

Theme: Classic Theme ~ Search:
| — |23 visual Design Wiindow SAP R/3 Classic Style
Therne Preview /Settings
Font Settings Standard Toolbar [Jstandard Application Toolbar

Color in Lists Application Toobar

Color in Forms

+| O3 Interaction Design

+I 3 Accessibiity & Scripting

+| O Multingual Settings

+|J Local Data

+|O Traces

I3 Security

+H 3 SAP Internal

+|C3 5P Logon Options

+| 3 Front: End Print
System Information

Status Bar

Ok Cancel Apphy Help Restore Defaults

Registry Values

Standard Toolbar

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Toolbar (REG_DWORD) [Default: 1]{0 =inactive; 1 = active}

Application Toolbar

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Buttonbar (REG_DWORD) [Default: 1] {0 = inactive; 1 = active}
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Status Bar

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Statusbar (REG_DWORD) [Default: 1]{0 =inactive; 1 = active}

Standard Application Toolbar

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Toolbar.RegularButtons (REG_DWORD) [Default: 0] {O = inactive; 1 = active}

7.2.8 Classic Design - Color in Lists Page

V- SaP GUI Options - SAP Lagon X

Theme: Classic Theme ~ Search:

| — |29 visual Design
Therne Preview /Settings
Font Settings &

MNarrmal Intensive Inverse

=

Color 1 Color 1 " Color 1

B " Color 2 (" Color 2 " Color 2
Color in Forms

+| O3 Interaction Design " Color 3 " Celor 3 C
+I 3 Accessibiity & Scripting
+| O Multingual Settings " Color 4 " Color 4 " Color 4
+|J Local Data
+|O Traces " Celor 5 T Celor 5 " Color 5
I3 Security
+H 3 SAP Internal [ Color 6 _ " Color 6
+I3 S4P Logon Options
FlC3I Front End Print " Color 7 I Color 7 " Color 7

System Information

Change Default (® Background Color

() Text Color
[Use list colors also in high contrast mode
[ show list background in SAP R./3 Classic style

Ok Cancel Apphy Help Restore Defaults
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Registry Values

Normal
[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Palette]
e Background Color

NormalColorl (REG_SZ) [Default: 255 128 128]{RGB value} till
NormalColor7 (REG_SZ) [Default: 227 199 235]{RGB value}

e Text Color
NormalTextl (REG_SZ) [Default:0 0 0]{RGB value}till
NormalText7 (REG_SZ) [Default: 0 0 0] {RGB value}

Intensive

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Palette]

e Background Color
IntensiveColorl (REG_SZ) [Default: 125 166 207]{RGB value} till
IntensiveColor7 (REG_SZ) [Default: 196 150 207]{RGB value}

e Text Color
IntensiveTextl (REG_SZ) [Default: 0 0 0]{RGB value}till
IntensiveText7 (REG_SZ) [Default: 0 0 0]{RGB value}

Inverse

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Palette]

e Background Color
InverseColorl (REG_Sz) [Default: 192 192 192]{RGB value} till
InverseColor7 (REG_Sz) [Default: 192 192 192]{RGB value}

e Text Color
InverseTextl (REG_SZ) [Default: 0 0 255]{RGB value} till
InverseText7 (REG_SZ) [Default: 204 0 204]{RGB value}

Use list colors also in high contrast mode

[HKEY CURRENT USER\Software\SAP\General\Appearance]

UseListColorSetting (REG_DWORD) [Default: 1] {O =inactive; 1 = active}

Show list background in SAP R/ 3 Classic style

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

ColorScheme (REG_DWORD) [Default: 0] {O = inactive; 1 = active}
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7.2.9 Classic Design - Color in Forms Page

Ve sap Gul Options - SAP Logon *
There: Classic Therme ~ Search:
| — |3 visual Design Colors
Theme Preview/Settings
Fort Settings Color Palethes
Options Standard e Copy to Custom
Field Colors
|03 Accessibility & Scripting Main Window - Background >
+| O Muldingual Settings
+|OLocal Data
+|(3 Traces
+| 3 Security Change

+|E3 AP Internal

+I3S4P Logon Options

-+ Front End Print Others
System [nformation

3D Effects

[0]4 Cancel Apply Help Restore Defallts

Registry Values

Color Palettes

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Palette]
Palette (REG_DWORD) [Default: 0]

Possible values: 1-12

Field Colors

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Palette]
Edit.BgndBrush (REG_Sz) [Default: 255 255 255] {RGB value}
Edit.FocusBrush (REG_SZ) [Default: 255 255 255] {RGB value}

Edit.TextNorm (REG_Sz) [Default:0 0 0}
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Edit.TextInt (REG_SZ) [Default: 255 0 0}

Read.BgndBrush (REG_Sz) [Default: system defined value for “Face color for three-dimensional display
elements and for dialog box backgrounds”] {RGB value}

Read.FocusBrush (REG_SZ) [Default: same value as Read.BgndBrush] {RGB value}
Read.TextNorm (REG_SZ) [Default:0 0 0]{RGB value}

Read.TextInt (REG_SZ) [Default: 0 0 255]{RGB value}

Static.TextNorm (REG_SZ) [Default: 0 0 0]{RGB value}

Static.TextInt (REG_SZ) [Default: 0 0 255]{RGB value}

Frame.BgndBrush (REG_Sz) [Default: same value as Read.BgndBrush] {RGB value}

View.BgndBrush (REG_Sz) [Default: same value as Read.BgndBrush] {RGB value}

3D Effects

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]
Shadow (REG_DWORD) [Default: 1]

ListEffect (REG DWORD) [Default: 1]

7.2.10 Applications Page

= SAP GUI Options

Find a setting | Visual Design

~ Visual Design Expert Option
Theme Settings = SapGuiServer
Font Settings
Branding
Color Settings
Applications

Interaction Design

Accessibility & Scripting

Multilingual Settings

Local Data

Traces

Security [ Add J [ Remove J
SAP Logon Options

Front End Print

Restore & Cleanup

R R N N YA VARV RV

System Information

Enable SAP GUI visual theme for listed applications that support this
m feature (for example: host application for SAP GUI Scripting Engine).
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i Note

This page is not displayed, if the Classic Theme is used and if the options dialogue is started from the
control panel or the start menu.

Registry Values

Application name in list
[HKEY CURRENT USER\Software\SAP\General\Applications\<application>], for example:
[HKEY CURRENT USER\Software\SAP\General\Applications\cscript]

In this example, cscript is the application name of cscript.exe.

Enable SAP GUI visual theme (checked/unchecked state)

[HKEY CURRENT USER\Software\SAP\General\Applications\cscript]

Enjoy (REG_Sz) [Default: on] {Off = inactive; On = active}

i Note

Special handling for read-only feature:

To set the whole page read-only/changeable, create the following registry value:

[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\General\Applications]
[HKEY LOCAL MACHINE\SOFTWARE\SAP\General\Applications] (on 32-Bit OS)

AppsSapGuiVisualTheme ReadOnly
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7.2.11 Keyboard Settings Page

| Find a setting

>

Visual Design

~ Interaction Design

SAP GUI Options - SAP Logon

' Interaction Design

Keyboard Settings

. [ ] Activate accelerator keys
Keyboard Settings i o . .

- — Access keys offer quick focus navigation by holding down [Shift+Ctrl+Alt] and
Visualization 1 pressing the required character keys. Note: This option does not work with
Visualization 2 languages with non-Latin characters.

Notifications [v] Automatically move focus to next input field on reaching the end of input field
Control Settings i o )
X [v] Remember cursor position within input fields
Sound Settings
> Accessibility & Scripting [v] Position cursor at the end of the value when entering a field
> Multilingual Settings |v] Automatically select complete value when entering a field in insert mode (INS)
7 Local bata [1 Automatically move mouse cursor to focused element (for magnifier tools)
> Tracing -
> Security LIZ Block selection (CTRL + Y) with TAB separated content
> SAP Logon Options
> Front-End Print
Restore & Cleanup
System Information
Registry Values

Activate access keys

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

UseClientAccesskeys (REG_DWORD) [Default: AccMode enabled — 1 otherwise 0] {O = inactive; 1 = active}

Automatically move focus to next input field

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

AutoTAB (REG_DWORD) [Default: 0] {O = inactive; 1 = active}

Remember cursor position within input fields

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

PositionTAB (REG_DWORD) [Default: 1] {O = inactive; 1 = active}

Position cursor at the end of value when entering a field

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]
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PositionMouse (REG_DWORD) [Default: 1]{O =inactive; 1= active}

Automatically select complete value

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Edit.EnterFieldSelectAll (REG_DWORD) [Default: 1]{0O = inactive;

Automatically move mouse cursor to focused element

[HKEY CURRENT USER\Software\SAP\General\Applications]

MouseFollowFocus (REG_DWORD) [Default: 0] {O = inactive; 1 = active}

Block Selection (CTRL + Y) with TAB separated content

1=active}

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

CopyAndPasteTabSeparated (REG_DWORD) [Default: 0] {O = inactive; 1 = active}
7.2.12 Visualization 1 Page
= SAP GUI Options - SAP Logon X
| Find a setting | Interaction Design
> Visual Design Cursor Width for Input Fields on Screens
v Interaction Design (® Narrow cursor O Wide cursor

Keyboard Settings [C] Use block cursor in overwrite mode (OVR)

r . . . l
Visualization 1

Visualization 2 Controls
Notifications [] Show keys within dropdown lists
Control Settings

Sound Settings

System Information

[ Sort by keys within dropdown lists for most efficient keyboard input

> Accessibility & Scripting OK Code
> Multilingual Settings Show OK Code field
» Local bata [¥] Show dialog box for OK Code in batch input
V] Show dialog box for ode in batch inpu
> Traces 8 - .
> Security .
. Lists

~ SAP Logon Options

General Use cursor within lists

Configuration Files Show lines in lists
> Front End Print [] Underline links in lists

Restore & Cleanup Allow Microsoft ClearType to be used for text in lists

Cancel Apply Help

SAP GUI Administration

48 PUBLIC Registry Values and Read-Only Feature of SAP GUI Options Dialog



Registry Values

Cursor Width for Input Fields on Screens

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Edit.CaretWidth (REG_DWORD) [Default: 2] {1 = narrow; 2 = wide}

Use block cursor in overwrite mode (OVR)

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Edit.BlockCursor (REG_DWORD) [Default: 0]{O = inactive;1= active}

Show keys within dropdown lists

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Dropdown.ShowKey (REG_DWORD) [Default: 0] {O = inactive; 1 = active}

Sort by keys within dropdown lists

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

Dropdown.SortKey (REG_DWORD) [Default: 0] {O = inactive; 1 = active}

i Note

This option can only be activated, if also Show keys within dropdown lists is activated.

Show OK Code field

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

HideCmdLinePermanently (REG_DWORD) [Default: 0]{O; 1}

Show dialog box for OK code in batch input

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

PopupBatchIn (REG_DWORD) [Default: 1]{O =inactive; 1 = active}

Use cursor within lists

HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

ListCursor (REG_DWORD) [Default: 1] {0 =inactive; 1 = active}

Show lines in lists

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

ListLines (REG_DWORD) [Default: 1]1{0 = inactive; 1= active}
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Underline links in lists

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

UnderlineHotspot (REG_DWORD) [Default: 0] {O = inactive; 1 = active}

Allow Microsoft ClearType to be used for texts in lists

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

ListAllowClearType (REG_DWORD) [Default: 1]{O = inactive; 1 = active}

7.2.13 Visualization 2 Page

= SAP GUI Options - SAP Logon X
Find a setting | Interaction Design
> Visual Design Window Title
~ Interaction Design [[] Show system name in taskbar button
Keyboard Settings
Visualization 1 Ellipsis
r N . . 1
_ Visualization 2 [v] Show ellipsis (.. if text cannot be displayed entirely
Notifications
Control Settings Enhanced Search
Sound Settings (¢) Show Enhanced Search automatically
> Accessibility & Scripting () Show Enhanced Search on demand using shortcut (Ctrl+Shift+Q)
> Multilingual Settings () Do not show Enhanced Search
> Local Data
> Traces Password Field
> Security [v] Show placeholder characters
> SAP Logon Options
> Front End Print
Restore & Cleanup
System Information
Registry Values

Show system name in taskbar button

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Administration]

ShowAdditionalTitleInfo (REG_DWORD) [Default: 0]{O =inactive; 1= active}
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Ellipsis
[HKEY CURRENT USER\Software\SAP\General\Appearance]

EllipsisForIl8n (REG_DWORD) [Default: 1] {O =inactive; 1= active}

Enhanced Search

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

EnhancedSearchMode (REG_DWORD) [Default: 1] {0 = do not show; 1 = show automatically; 2 = show on
demand}
Show placeholder characters

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

PasswordPlaceholderChars (REG_DWORD) [Default: 1]{0 = password field is not completely filled with
placeholder characters; 1 = password field is completely filled with placeholder characters}

7.2.14 Notifications Page

= SAP GUI Options - SAP Logon )4
| Find a setting | Interaction Design

> Visual Design Tooltip

~ Interaction Design Tooltip Delay |Medium (0.5 seconds) v

Keyboard Settings .
S [ Show tooltip on focus change
Visualization 1

Visualization 2

o .1 Messages
MNotifications g

Control Settings [] Beep at message

Sound Settings [] Show success messages in a dialog box
Accessibility & Scripting [[] Show warning messages in a dialog box
Multilingual Settings
Local Data

[] Show error messages in a dialog box

Traces

Security

SAP Logon Options
Front End Print
Restore & Cleanup
System Information

AR S S T
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Registry Values

Tooltip delay

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

BubbleDelay (REG_DWORD) [Default: 1]{0 = quick; 1 = medium; 2 = slow; 3 = none}

Show tooltip on focus change

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

BubbleOnTab (REG_DWORD) [Default: 0] {O = inactive; 1 = active}

Beep at message

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

BeepError (REG_DWORD) [Default: 0]{0O =inactive; 1= active}

Show success messages in a dialog box

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

PopupSuccess (REG_DWORD) [Default: 0] {O = inactive; 1 = active}

Show warning messages in a dialog box

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

PopupWarning (REG_DWORD) [Default: 0] {O = inactive; 1 = active}

Show error messages in a dialog box

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

PopupError (REG_DWORD) [Default: 0] {O = inactive; 1 = active}
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7.2.15 Control Settings Page

= SAP GUI Options - SAP Logon
| Find a setting | Interaction Design
> Visual Design Additional Control Services
~ Interaction Design [] Enable additional control services
Keyboard Settings Search Provider: |Google v
Visualization 1
Visualization 2
Notifications HTML Control
Control Settings Browser Control: Edge (based on Chromium) v)
Sound Settings Internet Explorer
— L Edge (based on Chromium)
> Accessibility & Scripting
> Multilingual Settings
> Local Data
> Traces
> Security
> SAP Logon Options
> Front End Print
Restore & Cleanup
System Information
Registry Values
Enable additional control sevices
[HKEY CURRENT USER\Software\SAP\General]
SAPGUIControlPlugin (REG_DWORD) [Default: 0]{O = inactive; 1= active }
Search Provider
[HKEY CURRENT USER\Software\SAP\General\ControlServices\WebSearchEngine]
WebSearchEngine (REG_SZ) [Default: Google] {AltaVista, Google, MSN, Yahoo}
Customizeable docking container position
i Note
Not available for Belize and Quartz Themes.
[HKEY CURRENT USER\Software\SAP\General]
SAPDockAllowMoveSave (REG_DWORD) [Default: 0] {O =inactive; 1 = active}
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Browser Control

[HKEY CURRENT USER\Software\SAP\General]

BrowserControl (REG_DWORD) [Default: 0] {O = Internet Explorer; 1= Edge (based on Chromium)}

i Note

Value 1 (Edge (based on Chromium)) is only available when the Microsoft WebView?2 control is available on
the client PC. The WebView?2 control can be obtained from Microsoft and can be distributed and updated
via the regular Microsoft distribution tools. See https://developer.microsoft.com/en-us/microsoft-edge/
webview?2/ # for more information.

7.2.16 Sound Settings Page

= SAP GUI Options - SAP Logon X
| Find a setting | Interaction Design
> Visual Design Audio Signal
v Interaction Design [] Activate audio signal
Keyboard Settings
: 4 — & Sound Scheme |SAP Percussion v
Visualization 1
Visualization 2 Messages
Notifications
a Success (»] | Success-Msgwav /[ Browse
Control Settings : -
" A Warning: (»] [ Warning-Msgwav | Browse
Sound Settings e
' / rror -
> Accessibility & Scripting ®| Error-Msgwav \ Browse
> Multilingual Settings
g ¢ Other Events
> Local Data
> Traces Checkbox/radio button @ | CheckBox.wav ‘ Browse
> Security Open dialog box (»] [ DialogBoxwav |[ Browse
> SAP Logon Options Expand/collapse tree E] | Expandwav ‘ Browse
> Front End Print Choose pushbutton E]| PushButtonwav |[ Browse
Restore & Cleanup Switch tab/page E] | TabStripwav \ Browse
System Information
Registry Values
Activate Audio Signal

[HKEY CURRENT USER\Software\SAP\General\Appearance]

Sound (REG_S2z) [Default: of£; in accessibility mode: on] {Off = inactive; On = active }
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Libraries
[HKEY CURRENT USER\Software\SAP\General\Appearance]

SoundLibrary (REG_DWORD) [Default: 0 - SAP Ethno]

Success
[HKEY CURRENT USER\Software\SAP\General\Appearance]

SND_MESSAGE_SUCCESS (REG_EXPAND_Sz) [Default: undefined; this means that the respective sound from
the standard library is used] {Contains the path and file name of the .wav file to be played. An empty value
means no sound is played.}

Warning

[HKEY CURRENT USER\Software\SAP\General\Appearance]

SND_MESSAGE_WARNING (REG_EXPAND_ Sz) [Default: undefined; this means that the respective sound from
the standard library is used] {Contains the path and file name of the .wav file to be played. An empty value
means no sound is played.}

Error

[HKEY CURRENT USER\Software\SAP\General\Appearance]

SND_MESSAGE_ERROR (REG_EXPAND_SZ) [Default: undefined; this means that the respective sound from the
standard library is used] {Contains the path and file name of the .wav file to be played. An empty value means
no sound is played.}

Checkbox/Radiobutton select

[HKEY CURRENT USER\Software\SAP\General\Appearance]

SND_CHECKBOX RADIOBUTTON CLICK (REG_EXPAND_ Sz) [Default: undefined; this means that the
respective sound from the standard library is used] {Contains the path and file name of the .wav file to be
played. An empty value means no sound is played.}

Dialog Box open

[HKEY CURRENT USER\Software\SAP\General\Appearance]

SND_DIALOGBOX_OPEN (REG_EXPAND_Sz) [Default: undefined; this means that the respective sound from
the standard library is used] {Contains the path and file name of the .wav file to be played. An empty value
means no sound is played.}

Expand/Collapse tree

[HKEY CURRENT USER\Software\SAP\General\Appearance]

SND_TREE_EXPAND COLLAPSE (REG_EXPAND_SZ) [Default: undefined; this means that the respective sound
from the standard library is used] {Contains the path and file name of the .wav file to be played. An empty value
means no sound is played.}

Pushbutton press

[HKEY CURRENT USER\Software\SAP\General\Appearance]
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SND_PUSHBUTTON CLICK (REG_EXPAND SZz) [Default: undefined; this means that the respective sound from
the standard library is used] {Contains the path and file name of the .wav file to be played. An empty value
means no sound is played.}

Tab/Page switch

[HKEY CURRENT USER\Software\SAP\General\Appearance]

SND_TABCONTROL CLICK (REG_EXPAND_ SZz) [Default: undefined; this means that the respective sound from
the standard library is used] {Contains the path and file name of the .wav file to be played. An empty value
means no sound is played.}

7.2.17 Accessibility Page

= SAP GUI Options - SAP Logon X
| Find a setting | Accessibility & Scripting
> Visual Design Accessibility Settings

> Interaction Design

v Accessibility & Scripting

f_ Accessibility_t
Scripting

Multilingual Settings

Local Data Desktop Office Integration

Traces

Security

SAP Logon Options

Front End Print

Restore & Cleanup

System Information

[[] Use accessibility mode

Include read-only and disabled elements in tab chain

Display symbols in lists as letters

[] Open Office documents outplace for better screen reader support

NN N NN

i Note

The Accessibility mode is not available for the following Corbu and Blue Crystal Themes.

Registry Values

Use accessibility mode
[HKEY CURRENT USER\Software\SAP\General]

AccMode (REG_Sz) [Default: o££]{Off = inactive; On = active }
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i Note

This option has to be activated to be able to activate the other options on this page.

Include read-only and disabled elements in tab chain

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Accessibility]

EnhancedTabChain (REG_DWORD) [Default: 1] {0 = inactive; 1 = active }

Display symbols in lists as letters
[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Accessibility]

SymbolsAsLetters (REG_DWORD) [Default: 1]{O = inactive; 1 = active }

Open Office documents outplace for better screen reader support
[HKEY CURRENT USER\Software\SAP\General]

OfficeOutplaceMode (REG_SZ) [Default: of£]{"on" = active, “off” = inactive}

7.2.18 Scripting Page

= SAP GUI Options - SAP Logon X
| Find a setting | Accessibility & Scripting
> Visual Design Installation

> Interaction Design

‘ Scripting is installed
~ Accessibility & Scripting

. Accessibjliw User Settings

_ Scripting, Enable scripting
> Multilingual Settings ) )
5 Local Data Notify when a script attaches to SAP GUI
S Traces Notify when a script opens a connection
> Security [] Show native Microsoft Windows dialogs
> SAP Logon Options
> Front End Print

Restore & Cleanup
System Information
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Registry Values

i Note

If SAP GUI Scripting is not installed, you see the corresponding message Scripting is not installed in the
Installation field. If this is the case, the options below cannot be set. For more information on SAP GUI
Scripting, see the SAP GUI Scripting Security Guide.

Enable Scripting

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Security]
UserScripting (REG_ DWORD) [Default: 1] {0 = inactive; 1 = active}

i Note

This option has to be activated to be able to activate the options mentioned below.

Notify when a script attaches to SAP GUI

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Security]

WarnOnAttach (REG_DWORD) [Default: 1] {O = inactive; 1 = active}

Notify when a script opens a connection

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Security]

WarnOnConnection (REG_DWORD) [Default: 1]{O = inactive; 1 = active}

i Note

The notification options can only be set via HKCU to leave the decision to the user, if he or she wants to
really deactivate the notification in case of script starts.

Show native MS Windows dialogs

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Scripting]
ShowNativeWinDlgs (REG_DWORD) [Default: 0] {O = inactive; 1 = active}

For more information on this feature, see SAP note 1974590 #& .
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7.2.19 IME Page

= SAP GUI Options - SAP Logon

| Find a setting | Multilingual Settings
> Visual Design Multibyte Input
> Interaction Design [] Continuous input on two lines
> Accessibility & Scripting
~ Multilingual Settings Close IME Automatically
r a
— [] On numeric or right-justified fields
Encoding ]
. [] On one-byte fields
Graphic
Orhers l ive IME On/Off K
> Local Data Alternative n ey
> Traces (® Shift + Space
> Security O crurl + Space
> SAP Logon Options O None
> Front End Print

Restore & Cleanup
System Information

Registry Values

Continuous input on two lines

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

KanjiContInpu (REG_ DWORD) [Default: 0] {O = inactive; 1= active }

Close IME on numeric or right-justified fields

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

ImeCloseRJustify (REG_DWORD) [Default: 0] {O = inactive; 1= active }

Close IME on one-byte fields

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

ImeCloseOneByte (REG_DWORD) [Default: 0] {O =inactive; 1 =active }

Alternative IME on/off key

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

KanjiKey (REG_DWORD) [Default: 0] {O = Shift + Space; 1= Ctrl + Space; 2 = None }
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7.2.20 Encoding Page

= SAP GUI Options - SAP Logon b4
| Find a setting | Multilingual Settings
> Visual Design Text Encoding
> Interaction Design [[] Auto-detect Latin1 characters
> Accessibility & Scripting
~  Multilingual Settings Keyboard Layout
IME : :
- A [ Adjust font to input language
. Encoding
Graphic SAP Code Page
Others i
S Local Data Adjust font to SAP code page at logon
> Traces
> Security
> SAP Logon Options
> Front End Print
Restore & Cleanup
System Information
Registry Values

Auto-detect Latinl characters
[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

LatinlAutoDetect (REG_ DWORD) [Default: 0] {O = inactive; 1 = active }

Adjust font to the input language
[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

AdjustFontToKL (REG_DWORD) [Default: 0] {O =inactive; 1 =active }

Adjust font to SAP code page at logon
[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

AdjustFontToSapCP (REG_DWORD) [Default: 1] {0 =inactive; 1 = active }
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7.2.21 Graphic Page

= SAP GUI Options - SAP Logon X
| Find a setting | Multilingual Settings
> Visual Design Text Font
> Interaction Design [ User setting
> Accessibility & Scriptin
. v i pting Small: | | Select
v Multilingual Settings
IME Medium: | | Select
Encoding
r - Large: | | Select
. Graphic
Others Local Texts
> Local Data i
Always use this language:
> Traces
> Securi .
v . PostScript Font
> SAP Logon Options
S Front End Print Font File to Load (Environment Variable PSFONTFILE)
Restore & Cleanup ‘ | [ Browse... ] [ Clear J
System Information Font Name (Environment Variable PSFONTNAME)
‘ | [ Change ] [ Clear J

For this page, no values are stored in the registry, but in the SAP Graphics configuration file and environment
variables.

i Note
Special handling for read-only feature:
To set the whole page read-only/changeable, create the following registry value:

[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\SAPGUI Front\SAP Frontend Server

\Customize]

[HKEY LOCAL MACHINE\SOFTWARE\SAP\SAPGUI Front\SAP Frontend Server\Customize](on
32-Bit 0OS)

GraphicsSettings_ReadOnly
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7.2.22 Others Page

= SAP GUI Options - SAP Logon X
| Find a setting | Multilingual Settings
> Visual Design Shortcut Key
> Interaction Design [] Hide shortcut key for multibyte menu
> Accessibility & Scripting
~  Multilingual Settings Function Code
IME [ Do not send function code when IME is open
Encoding
Graphic System Parameters
r A
L Othersl Menu Font: ‘ Segoe Ul, 9 |
> Local Data
> Traces Title Font: ‘ Segoe U, 9 |
> Security
> SAP Logon Options Local Texts
> Front End Print [] Use language setting of SAP Logon
Restore & Cleanup
System Information RTL/LTR Layout
[v] Set layout in accordance with logon language
Registry Values

Hide shortcut key for multibyte menu

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

KanjiHideShortcut (REG_DWORD) [Default: 0] {O = inactive; 1 = active }

Do not send function code when IME is open

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

KanjiSuppressPFKey (REG_DWORD) [Default: 0] {0 = inactive; 1 = active }

System parameters

= Windows system parameters

Use SAP Logon language setting

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

UseSaplogonLang (REG_DWORD) [Default: 0] {O = inactive; 1 = active }
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RTL/LTR Layout - Set layout in accordance with the logon language

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]

BidirectOnLang (REG_DWORD) [Default: 1]1{0O = inactive; 1 = active }

7.2.23 History Page

= SAP GUI Options - SAP Logon

‘ Find a setting | Local Data
> Visual Design History Status
> Interaction Design O off ® on O Immediately
> Accessibility & Scripting
> Multilingual Settings History Settings
v Local Data
.r History—: Expiry Time [Month(s)]:
Cache
Maximum Permitted File Size [MB]: 10
File Lifetime L] -
Local Tab Order Maximum Number of Entries:
> Traces
> Security Enable History for Fields Up To [Characters]:
> SAP Logon Options
> Front End Print [ Clear History ]
Restore & Cleanup
System Information Directory for Input History:
‘ CiUsers\d03\AppData\Roaming\SAP\SAP GUNHistory ‘ Select
Registry Values
History Status

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]

ShowMode (REG_ DWORD) [Default: 1] {0 = Off; 1 = on; 2 = Immediately }

Expiry Time
[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]

Expiration (REG_DWORD) [Default: 3]{0 -1000}

Maximum Permitted Files Size

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]
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FileSize (REG_DWORD) [Default: 10]{0 - 200}

Maximum Number of Entries
[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]

NoEntries (REG_DWORD) [Default: 20]{1- 99}

Enable History for Fields up to [character]
[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]

FieldLenHistoryOn (REG_DWORD) [Default: 59] {1 - 255}

Directory for Input History
[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]

DataPath (REG_Sz) [Default: C:\Users\<USERNAME>\%AppData%\Roaming\SAP\SAP GUI\History]
{valid path with write permission}

A Caution

Different registry key/value under HKLM, which can be set via installation (for further information see
Installation Guide):

[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\SAP Shared]

SAPhistorydir (REG_EXPAND SZ)

7.2.24 Cache Page

= SAP GUI Options - SAP Logon X
‘ Find a setting | Local Data
> Visual Design Local Cache
’ Interactllo.rr DESIgn_ . Maximum Cache Size [MB]:
> Accessibility & Scripting —
> Multilingual Settings Maximum Cache File Size [KB]: 5120 |5
~ Local Data
History Directory for Local Cache Data:
r =
_ Cache ‘ C\Users\d03\AppData\Local\SAP\SAP GUNCache |
File Lifetime
Local Tab Order [ Delete Local Cache Files ]
> Traces
> Security
> SAP Logon Options
> Front End Print
Restore & Cleanup
System Information
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Registry Values

Maximum Cache Size

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]

MaxCacheSize (REG_ DWORD) [Default: 50] {0 - 10000 MB}

i Note

Saved in Bytes not MB; default in Bytes: 52428800.

Maximum Cache File Size

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]

MaxCacheFileSize (REG_DWORD) [Default: 5120]{0 - 10000 KB}

i Note

Saved in Bytes not KB; default in Bytes: 52428800.

If you have adjusted your local settings for these parameters, the change of the default values will not have any
impact on you.

Additionally, if you are updating your SAP GUI installation, the change will also not have any impact, because up
to patchlevel 3 of SAP GUI for Windows 7.50 the SAP GUI Installation wrote the old default settings into the
Windows registry. Therefore, in case of an update, you either have to remove the registry values
MaxCacheSize and MaxCacheFileSize under HKLM\Software\SAP\SAPGUI Front\SAP Frontend
Server\LocalData or define sensible values via the SAP GUI Options dialog (these settings are persisted
under HKCU).

For more information on the default settings, see note 2565360#% (Adjusted default settings for client file
cache in SAP GUI for Windows).
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7.2.25 File Lifetime Page

= SAP GUI Options - SAP Logon X
‘ Find a setting | Local Data
> Visual Design Deletion of Files and Subfolders in Documents Folder
> Interaction Design @® Never
> Accessibility & Scripting (O Always during SAP Logon (Pad) shutdown
7 Multilingual Settings () Eile lifetime (date modified) [days]: -
v Local Data Directory for Documents:
History :
Cache ‘ C:\Users\d03\OneDrive - SAP SE\Documents\SAP\SAP GUI |
. . . i
_ File Lifetime [ Open Documents Folder ]
Local Tab Order
> Traces Deletion of Files in Traces Folder
> Security @® Never
> SAP Logon Options (O Always during SAP Logon (Pad) shutdown
> Front End Print () File lifetime (date created) [days]: -
Restore & Cleanup . .
Directory for Traces:
System Information
‘ CiUsers\dO3\AppData\Local\SAP\SAP GURTraces\ |
[ Open Traces Folder J
Deletion of Files from Chromium Edge Browser Control
[ Clear Browser Control Cache ]
Registry Values

Deletion of Files in Documents Folder

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]

DeleteDocuments (REG_ DWORD) [Default: 0]
DocumentLifetime (REG_ DWORD) [Default: 0]

® Never (DeleteDocuments = 0 and DocumentLifetime = 0)

e Always during SAP Logon (Pad) shutdown (DeleteDocuments =1 and DocumentLifetime = 0)

e Filelifetime (DeleteDocuments = 1 and DocumentLifetime ={1 - 30})
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i Note

Special handling for read-only feature:

Setting most options changeable and only some exceptions read-only:

Itis enough to set one of the two registry values read-only, so that the radio buttons will be disabled.
Setting most options read-only and exceptions changeable:

For both registry values a corresponding *_ReadOnly REG_DWORD registry value must be created and set
to 0, so that the radio buttons will be enabled.

Deletion of Files in Traces Folder

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]
DeleteTraces (REG_DWORD) [Default: 0]

TraceLifetime (REG_ DWORD) [Default: 0]

® Never (DeleteTraces = 0 and TraceLifetime = 0)
e Always during SAP Logon (Pad) shutdown (DeleteTraces =1 and TraceLifetime = 0)
e Filelifetime (DeleteTraces =1 and TraceLifetime ={1 - 30})

i Note

Special handling for read-only feature:

Setting most options changeable and only some exceptions read-only:

Itis enough to set one of the two registry values read-only, so that the radio buttons will be disabled.
Setting most options read-only and exceptions changeable:

For both registry values a corresponding *_ReadOnly REG_DWORD registry value must be created and set
to 0, so that the radio buttons will be enabled.

Deletion of Files from Chromium Edge Browser Control

The button Clear Browser Control Cache does not support the read-only feature, because the cache can
contain personal data, which the user must be able to delete.
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7.2.26 Local Tab Order Page

= SAP GUI Options - SAP Logon X

‘ Find a setting | Local Data

Visual Design Local Tab Order

Interaction Design Directory for Local Tab Order Database:

>

b

> Accessibility & Scripting | CaUsers\d03\AppDatalRoaming\SAP\SAP GUNLocalTabOrder |
> Multilingual Settings

N

Local Data [ Clear Local Tab Order J

History

Cache

File Lifetime

Local Tab Order
Traces
Security
SAP Logon Options
Front End Print
Restore & Cleanup

NOONON N

System Information

Registry Values

Directory for local tab order database

[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\LocalData]

LocalTabOrderPath (REG_EXPAND Sz) [Default: $APPDATA%\SAP\SAP GUI\LocalTabOrder]{valid
path with write permission}

i Note
Special handling for read-only feature:
To enable/disable the button Clear local tab order, create the following registry value:

[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\SAPGUI Front\SAP Frontend Server
\LocalData]

ClearLocalTabOrder ReadOnly
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7.2.27 Session Traces Page

- - Calendar
Session Traces

SAP GUI Traces
SAP Logon Traces

Diag Parser

‘ Find a setting | Traces

> Visual Design Session Trace

> Interaction Design Abap Editor

> Accessibility & Scripting Access Control

> Multilingual Settings Qg\éagrcisd Tree Control

> Local Data Automation

Border Painter Control

~  Traces

SAP GUI Options - SAP Logon

-~

[] Time stamps

I [] Memory
["] Detailed output

Context Manager
Control Manager
Crystal Container

>

Security

. Select All
> SAP Logon Options

J |

Deselect All ]

> Front End Print
Restore & Cleanup
System Information

Display Options

Trace Folder:

[] Show window

[] View on disable

| C:\Users\d03\AppData\Local\SAP\SAP GUNTraces\

[ Enable

J [ Delete All Trace Files ] [ Open Trace Folder]

m Trace(s) are enabled/disabled in all new sessions.

Cancel Apply

Help

This page is only needed for error analysis and the creation of traces will only be triggered by SAP support

employees. The SAP GUI security settings are independent of the read-only feature described below.

i Note

Special handling for read-only feature:

To set the whole page read-only/changeable create the following registry value:

[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\SAPGUI Front\SAP Frontend Server

\Trace]

[HKEY LOCAL MACHINE\SOFTWARE\SAP\SAPGUI Front\SAP Frontend Server\Trace](on 32-Bit

0S)

SessionTrace ReadOnly
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7.2.28 SAP GUI Traces Page

= SAP GUI Options - SAP Logon X
‘ Find a setting | Traces

> Visual Design SAP GUI Trace

> Interaction Design @ Trace deactivated

> Accessibility & Scripting O Level 1: Errors

> Multilingual Settings B i

g g () Level 2: Errors and Warnings
> Local Data ) )
o Traces () Level 3: All (Diagnostic Trace)

Session Traces
" SAP GUI Traces,
SAP Logon Traces
Security
> SAP Logon Options
> Front End Print
Restore & Cleanup

[ Delete All Trace Files J [ Open Trace Folder J

System Information

This page is only needed for error analysis and creating traces will be only triggered by SAP support employees.

i Note

Special handling for read-only feature:

To set the radio buttons read-only/changeable create the following registry value:
[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\SAPGUI\Trace]
[HKEY LOCAL MACHINE\SOFTWARE\SAP\SAPGUI\Trace] (on32-Bit OS)

Level ReadOnly
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7.2.29 SAP Logon Traces Page

= SAP GUI Options - SAP Logon X
‘ Find a setting | Traces
> Visual Design SAP Logon Trace
> Interaction Design @® Trace deactivated
> ACCE-S.SIbIlIty & S-crlptlng O Errors
> Multilingual Settings O Errors and warnings
> Local Data . .
() Errors, warnings, and monitor
~  Traces o . . P
. rrors, warnings, monitor, and detailed output
Session Traces O g P
() Errors, warnings, monitor, detailed output, and time stamp

SAP GUI Traces
Ir SAP Logon Tracesjl
Security
> SAP Logon Options
> Front End Print
Restore & Cleanup

[ Delete All Trace Files J [ Open Trace Folder ]

System Information

This page is only needed for error analysis and creating traces will be only triggered by SAP support employees.

i Note

Special handling for read-only feature:

To set the radio buttons read-only/changeable create the following registry value:
[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\SAPLogon\Options]
[HKEY LOCAL MACHINE\SOFTWARE\SAP\SAPLogon\Options] (on 32-Bit OS)

SapLogonTraceLevel ReadOnly
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7.2.30 Security Settings Page

SAP GUI Options - SAP Logon

[

Restore & Cleanup
System Information

‘ Find a setting | Security
> Visual Design Security Module
> Interaction Design Status:
> Accessibility & Scripting
> Multilingual Settings [ Open Security Configuration
> Local Data
> Traces Security Rule Status
v Security Default Action:
Security Configuration
- SAP Rules:
> SAP Logon Options
> Front End Print Administrator Rules (Total/Disabled):

User Rules (TotaU/Disabled):

Cancel

|/ 1l
Disabled ~

Disabled
Customized
Strict Deny

Ask

458

|2m;o

|8i0

Apply

Help

How to disable and set security settings is described in the Security Guide.

i Note

Special handling for read-only feature:

To disable/enable editing, creating, deleting, and changing of the priority of user rules, create the following
registry value:

[HKEY LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\SAPGUI Front\SAP Frontend Server
\Security]

[HKEY LOCAL MACHINE\SOFTWARE\SAP\SAPGUI Front\SAP Frontend Server\Security](on 32-
Bit OS)

UserRuleEditing ReadOnly
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7.2.31 SAP Logon Options - General Page

= SAP GUI Options - SAP Logon b4
| Find a setting | SAP Logon Options
> Visual Design SAP Logon Options
> Interaction Design Language: EN
> Accessibility & Scriptin,
.. i . piing Use SAP Logon language as default on logon screen
> Multilingual Settings
> Local Data Message Server Timeout in Seconds 10 [ Use Default J
> Traces Confirm deletion of connection entries
> Security ["] Disable editing of connection entries
~ SAP Logon Options
- g 4 P [C] Hide SAP Logon (Pad) in tray bar
. General

Configuration Files

> Front End Print
Restore & Cleanup Additional Command Line Arguments:

SAP GUI Start Options

System Information

Registry Values

Language
[HKEY CURRENT USER\Software\SAP\General]

Language (REG_ Sz) [Default: 0S default language] {two characters language shortcut: see the
dropdown box in SAP GUI Options dialog}

Use SAP Logon language as default language on logon screen

[HKEY CURRENT USER\Software\SAP\SAPLogon\Options]
UseSAPLogonLanguageAsDefault (REG_ DWORD) [Default: 1]{ O = inactive; 1 = active}

You find more information on this feature under Setting Logon Language [page 13].

Message Server Timeout

[HKEY CURRENT USER\Software\SAP\SAPLogon\Options]

MessageServerTimeout (REG_DWORD) [Default: 10]

Confirm deletion of connection entries

[HKEY CURRENT USER\Software\SAP\SAPLogon\Options]
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ConfirmDelete (REG_DWORD) [Default: 1]{0 = inactive; 1 = active}

Disable editing of connection entries

[HKEY CURRENT USER\Software\SAP\SAPLogon\Options]

NoEditFunctionality (REG_DWORD) [Default: 0]{O =inactive; 1= active}

Hide SAP Logon (Pad) to tray bar

[HKEY CURRENT USER\Software\SAP\SAPLogon\Options]

HideToTrayBar (REG_DWORD) [Default: 0]{O = inactive; 1 = active}

SAP GUI Start Options — Additional Command Line Arguments

[HKEY CURRENT USER\Software\SAP\SAPLogon\Options]

SapguiNTCmdOpts (REG_SZz) [Default: ""] {valid SAP GUI command line argument(s)}

i Note
The reading priority for these registry values is as follows:

e SAP Logon: HKCU —» HKLM
e SAP Logon Pad: HKLM - HKCU

For “Language” take into account that the default value (in case both registry values under HKCU and
HKLM are not defined) is the operating system language. For Use SAP Logon language as default language
on logon screen and Hide SAP Logon (Pad) to tray bar the reading sequence was changed in SAP GUI for
Windows 7.70 patchlevel 2. As of this patch, these values take the reading priority HKCU -> HKLM and they
are active by default even in SAP Logon Pad. If you want to make these options inactive, use the read-only
feature for these options, see also Read-Only Feature of the SAP GUI Options Dialog [page 18].
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7.2.32 SAP Logon Options - Configuration Files Page

= SAP GUI Options - SAP Logon X
| Find a setting | SAP Logon Options
> Visual Design Configuration Files
> Interaction Design Path to local configuration files:
> Accessibility & Scripting ‘ CiUsers\d03\AppData\Roaming\SAP\Common |
> Multilingual Settings XML Configuration File on Server:
> Local Data ‘ |
> Traces
> Security Configuration File Caching
~ SAP Logon Options Allow caching of remote configuration files
General (®) Update cache on every SAP Logon (Pad) start
r . . . l
, Configuration Files (O Update cache only in an interval of [hours]:
2 Front End Print Path: | C:\Users\d03\AppData\Roaming\SAP\LogonServerConfigCache |
Restore & Cleanup
System Information Loaded Files
Type Path

Local File CAUsers\d03\AppData\Roaming\SAP\Commonm\SAPUILandscape xml

Registry Values

Path to Local Configuration Files

[HKEY CURRENT USER\Software\SAP\SAPLogon\Options]

PathConfigFilesLocal (REG_EXPAND SZz) [Default: $APPDATA%\SAP\Common] {valid path with write
access}

i Note
The reading priority for these registry values are as follows:

e SAP Logon: HKCU —» HKLM
® SAP Logon Pad: HKLM - HKCU

XML Configuration File on Server

Depending on the configuration of your landscape, different file paths are displayed here, if they are not
overwritten by the user:

[HKEY CURRENT USER\Software\SAP\SAPLogon\Options]

LandscapeFileOnServer (REG_EXPAND  Sz) [Default: ""]{valid path to the correct configured XML-File}
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Or if you have created a core configuration file that can be supplied and set only by an administrator and not by
the users:

[HKEY LOCAL MACHINE\SOFTWARE\SAP\SAPLogon\Options](32-Bit OS)
[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\SAPLogon\Options] (64-Bit OS)
CoreLandscapeFileOnServer (REG_EXPAND Sz) [Default: “"]

For more information on the configuration with SAP Ul Landscape, see the SAP GUI for Windows Installation
Guide, chapter 2 ‘Configuration Information’
Allow caching of remote configuration files

[HKEY CURRENT USER\Software\SAP\SAPLogon\Options]

AllowCachingServerConfigFiles (REG_DWORD) [Default: 1] {O =inactive; 1= active}

i Note

The term remote configuration files refers to the server (“central™) SAP Ul Landscape file as well as to the
core configuration file and files specified by command line parameter or environment variable, but located
on a remote server.

Update cache...

[HKEY CURRENT USER\Software\SAP\SAPLogon\Options]

LandscapeCacheExpiryPeriod (REG_DWORD) [Default: 0] {O = update on every SAP Logon (Pad) start;
[60, 599940] = interval in minutes}

You find more information on the caching features in the SAP GUI Frontend Installation Guide in section
"Caching Remote Configuration Files".

i Note

Note the reading priority for these registry values:

® SAP Logon: HKCU - HKLM
e SAP Logon Pad: HKLM - HKCU

Loaded Configuration Files

In this list box, type and path of the loaded server files are displayed.

Type Description

Local File This is the SAP Ul Landscape file containing user specific en-
tries located inthe Path to local configuration
files folder.
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Type Description

Server file This file type is displayed in two cases and shows the file
listed under XML Configuration File on Server:

® CorelandscapeFileOnServer und
LandscapeFileOnServer are set; in this case
LandscapeFileOnServer overrules the other set-
ting

® only LandscapeFileOnServer is set

General File Only CoreLandscapeFileOnServer, but not

LandscapeFileOnServerisset.

Include File An SAP Ul Landscape file may contain include statements
pointing to further SAP Ul Landscape files. A file referenced
by such an include statement is listed with this type.

Please, note that only the first level of included files is listed,
this means that a file included by an included file is not listed
here.

Command Line Parameter SAP Logon (Pad) can be started with command line parame-
ter /LSXML_FILE. Inthis case, the SAP Ul Landscape file
provided as parameter to this call is listed here with type
Command Line Parameter.

Environment Variable SAP Logon (Pad) evaluates the environment variable
SAPLOGON_ LSXML_FILE which determines the location
of the SAP Ul Landscape file to be used. In this case, the SAP
Ul Landscape file provided via environment variable is listed
here with type Environment Variable.

i Note

By double-clicking the configuration file entries in the listbox, you can display their content in the
associated application for displaying XML files.
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7.2.33 Frontend Print Settings Page

SAP Logon Options
Front End Print

r L1
_ Front End Print
Restore & Cleanup
System Information

= SAP GUI Options - SAP Logon X
| Find a setting | Front End Print
> Visual Design Front End Print
> Interaction Design - -
> Accessibility & Scripting [ Configure Front End Print J
> Multilingual Settings
> Local Data
> Traces
> Security
>
~

To configure front end printing, choose Configure Front End Print. This leads you to the print options editor. You
find more information in the print options help or in 1149136 # .

i Note

The Configure Front End Print button is read-only by default. To view the frontend print options, you have to
activate this button via the keys listed below. Note that to do this, you have to switch to another mode of
the read-only feature (see Read-Only Feature of the SAP GUI Options Dialog [page 18]):

[HKEY LOCAL MACHINE\Wow6432Node\Software\SAP\General\Appearance]

FrontEndPrint ReadOnly (REG_DWORD)
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7.2.34 Restore & Clean Up Page

= SAP GUI Options - SAP Logon X
‘ Find a setting |
> Visual Design Restore & Cleanup
> Interaction Design [] Restore SAP GUI default settings
> Accessibility & Scriptin
L. Yy . piing [[] Delete all user-defined security rules
> Multilingual Settings
S Local Data [] Clear input history
> Traces [] Delete local cache files
> Security [T] Clear local tab order
> SAP Logon Options o
. [[] Delete all files in document folder
> Front End Print
:— Restore & Cleanup—: [[] Delete all files in temp folder
System Information [[] Delete all files in trace folder

[] Clear Chromium Edge browser control cache

Restore and Cleanup

Migrate Configuration & Settings

( — ) T )

after restarting the SAP Logon Pad.Close all SAP GUI sessions and SAP

m Restoring the default settings and clearing the local tab order take effect
Logon Pad after applying these changes.

The (de)activation of the items on the Restore & Cleanup page requires special handling for the read-only
feature:

Setting AllOptionsReadOnly deactivates only the checkboxes Restore SAP GUI default settings, Delete all user-
defined security rules and Clear local tab order. The other checkboxes and the button Restore and Cleanup
cannot be disabled at all, because the user must be able to delete the respective files/settings, because they
might contain person-related data.

The same situation can be achieved by using the following registry value:

[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance]
RestoreDefaults_ReadOnly [Default: 0]

You can explicitly disable Clear local tab order using the following registry value:
[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance]
ClearLocalTabOrder ReadOnly [Default: 0]

The database for the local tab order does not contain any person-related data and the administrator may wish
to prevent the deletion of a local tab order database that has been deployed together with SAP GUI.
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Furthermore, you can disable Delete all user-defined security rules by setting the following registry value:

[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\SAPGUI Front\SAP Frontend Server
\Security]

DeleteAllUserDefinedSecurityRules_ReadOnly [Default: 0]

The user-defined security rules also do not contain any person related data.

To disable the Import and Export buttons use the following registry keys:

[HKEY LOCAL MACHINE\SOFTWARE\WOW6432Node\SAP\General\Appearance]
ImportConfigurationAndSettings_ ReadOnly [Default: 0]
ExportConfigurationAndSettings_ReadOnly [Default: 0]

Last but not least, you can enable or disable Restore SAP GUI default settings by setting the following registry
value:

[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance\]

RestoreSAPGUIDefaultSettings_ReadOnly [Default: 0]

7.2.35 System Information Page

= SAP GUI Options - SAP Logon X
‘ Find a setting |
> Visual Design System Information
> Interaction Design Release: | 770 Final Release |
> Accessibility & Scripting ]
> Multilingual Settings File Name: | e |
> Local Data File Version: |??OO.1.0.1161 |
> Traces
. Build: | 2031029 |
> Security
> SAP Logon Options Patch Level: | 0 |
> Front-End Print
Restore & Cleanup
r . al
_ System Information Installation Check
[ Check SAP GUI Installation J
Bl e Help

As of patchlevel 5 of SAP GUI for Windows 7.60, you can disable the Check SAP GUI Installation button using
the read-only feature.

To achieve this, use the following registry value:

[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\General\Appearance]
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InstallationCheck ReadOnly [Default: 0]
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8 Registry Values of SAP GUI in General

8.1 Displaying OK Code Field and Status Bar Info

= User System Help

1) hd ‘ More Exit
Client: || Information -
_ _ Development System I
User: ‘
Main Clients:
000 Development / Pl Integration Server
Logon Language: El 100 Customizing R
= .. s — Y
Enter a valid SAP user or choose one from the list @
Registry Values

1- OK field opened
[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]
HideCmdLinePermanently (REG_DWORD) [Default: 0]

{0 = OKCode field opened; 1 = OKCode field closed}

2 - Display Status Bar Info
[HKEY CURRENT USER\Software\SAP\SAPGUI Front\SAP Frontend Server\Customize]
Statusbar.Layout (REG_DWORD) [Default: 1]

{0 =inactive; 1 = active}
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8.2 Disabling Input History via Registry

You have the possibility to completely disable the input history via registry. The history database will not be
created in this case.

Registry Values

To disable history, set the DWORD registry value DisableHistory to 1 either under HKEY LOCAL MACHINE
orunder HKEY CURRENT USERIinthe LocalData location: \software\sap\SAPGUI Front\SAP

Frontend Server\LocalData.

i Note
On 64bit operating systems, the value under HKEY LOCAL MACHINE needs to be placed under:
HKEY LOCAL MACHINE\software\Wow6432Node\sap\SAPGUI Front\SAP Frontend Server
\LocalData

The reading order is as follows:

First, the registry value will be checked under HKEY LOCAL MACHINE. If not definied there, the registry value
will be checked under HKEY CURRENT USER.

8.3 Disabling/Setting Read-Only the Local Tab Order via
Registry

You have the possibility to completely disable the local tab order functionality via registry or to set it read-only.

Registry Values

[HKEY LOCAL MACHINE\SOFTWARE\SAP\SAPGUI Front\SAP Frontend Server\LocalData]

[HKEY LOCAL MACHINE\SOFTWARE\Wow6432Node\SAP\SAPGUI Front\SAP Frontend Server
\LocalData] on 64bit operating systems

DisableLocalTabChain (= 1 means local tab order disabled)

LocalTabOrderReadOnly (= 1 means local tab order read-only)
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9 Appendix

9.1 Related Information

Source Location

SAP Community SAP GUI Community e
SAP GUI Family wiki#

SAP Help Portal SAP GUI Online Help

9.2 Registry Keys Overview

The following registry key overview contains the registry keys as titles and the registry key data in the table

following the title.

9.2.1 Software\SAP\General

Value Type Default Reading Priority Chapter/Reference
AccMode REG_SZ Off HKCU — HKLM Accessibility Page
[page 56]
AllOptionsReadOnly REG_DWORD See ref. See ref. Read-Only Feature of
the SAP GUI Options
Dialog [page 18]
AllOptionsReadOnly =~ REG_DWORD See ref. See ref. Read-Only Feature of

the SAP GUI Options
Dialog [page 18]
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Value Type Default Reading Priority Chapter/Reference
BrowserControl REG_DWORD 0 HKCU - HKLM Control Settings Page
[page 53]
BrowserControlFall- REG_SZ See ref. HKCU - HKLM SAP Note 2957665
backConfiguration
CurRegValReadOn- REG_DWORD See ref. See ref. Read-Only Feature of
lyActive the SAP GUI Options
Dialog [page 18]
EdgeBrowserEnable- REG_DWORD 0 HKLM = HKCU SAP Note 2955264
DevToolsWindow
EdgeBrowserContro- REG_DWORD 1 HKCU - HKLM SAP Note 2942740
IUseSAPGUIFont
Language REG_SZ OS default language HKCU —» HKLM SAP Logon Options -
General Page [page
73]
OfficeOutplaceMode  prq 57 Off HKCU - HKLM Accessibility Page
[page 56]
SAPDockAllowMove- REG_DWORD 0 HKCU - HKLM Control Settings Page
Save [page 53]
SAPGUIControlPlugin REG_DWORD 0 HKCU -» HKLM Control Settings Page

[page 53]

9.2.2 Software\SAP\General\Appearance

Value Type Default Reading Priority Chapter/ Reference

AccClassicMenubar- REG_DWORD 1 HKCU - HKLM see note 1515235 ¥

BehaviorActive

ActivateFioriFeatures REG_DWORD 1 HKCU —» HKLM Theme Settings Page
[page 20]

AdjustFontHeight- REG_DWORD 1 HKCU - HKLM see note 2106323t

ToDPI

AnimatedFocus REG_DWORD 1 HKCU - HKLM Theme Settings Page
[page 20]

BelizeDefault Color REG_SZ i HKCU - HKLM SAP GUI Default Color

[page 14]
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Value Type Default Reading Priority Chapter/ Reference
BlueCrystalDefault- REG_SZ " HKCU -» HKLM SAP GUI Default Color
Color [page 14]
Brandinglmage REG_SZ none HKCU - HKLM Branding Page [page
26]
Brandinglmage_Re- REG_DWORD 0 only HKLM Branding Page [page
adOnly 26]
CIearLocacI)TabOr- REG_DWORD 0 only HKLM Restore & Clean Up
der_ReadOnly Page [page 79]
Corbulcon REG_DWORD 0 HKCU - HKLM Theme Settings Page
[page 20]
EllipsisForl18n REG_DWORD 0 HKCU - HKLM Visualization 2 Page
[page 50]
ExportConfiguratio- REG_DWORD 0 only HKLM Eesto[re & C;(;a:]rgutp
i - age [page ata
nAndSettings_Re Migration for End
adOnly Users [page 7]
FioriToolbarButtons- REG_DWORD 0 HKCU - HKLM Theme Settings Page
Withlcons [page 20]
FrontEndPrint_Re- REG_DWORD 0 only HKLM Frontend Print Settings
adOnly Page [page 78]
ImportConfiguratio- REG_DWORD 0 only HKLM lFiesto[re & CI%a]nDUtp
. ) age [page ata
nAndSettings_Re Migration for End
adOnly Users [page 7]
LunarFollowFocusMe- REG_DWORD 0 HKCU - HKLM see note 1552357 #
nuActive
MultiMonitorDpiA-  REG_DWORD 0 HKCU - HKLM Theme Settings Page
[page 20]
wareness
QuartzDefaultColor ~ REG-SZ 0 HKCU - HKLM SAP GUI Default Color
[page 14]
QuartzDarkDefault-  REG-SZ 0 HKCU - HKLM SAP Gﬂ Default Color
Color [page 14]
RestoreDefaults_Re- REG_DWORD 0 HKLM Restore & Clean Up
adOnly Page [page 79]
SelectedFallback- REG_DWORD 256 HKCU -» HKLM Theme Settings Page

Theme

[page 20]
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Value Type Default Reading Priority Chapter/ Reference
SelectedTheme REG_DWORD 256 HKCU -» HKLM Theme Settings Page
[page 20]
ShowShadowBorder = REG_DWORD 1 HKCU - HKLM Theme Settings Page
[page 20]
SignatureDefault- REG_SZ " HKCU - HKLM Color Settings Page
Color [page 28]
SignatureSystemDe- REG_DWORD 1 HKCU ~ HKLM Color Settings Page
pendentColorsActive [page 28]
SND_CHECKBOX_RA- REG_EXPAND_SZ undefined HKCU - HKLM Sound Settings Page
DIOBUTTON_CLICK [page 54]
SND_DIALOG- REG_EXPAND_SZ undefined HKCU -» HKLM Sound Settings Page
BOX_OPEN [page 54]
SND_MESSAGE_ER- REG_EXPAND_SZ undefined HKCU —» HKLM Sound Settings Page
ROR [page 54]
SND_MESSAGE_SUC- REG_EXPAND_SZ undefined HKCU - HKLM Sound Settings Page
CESS [page 54]
SND_MES- REG_EXPAND_SZ undefined HKCU - HKLM Sound Settings Page
SAGE_WARNING [page 54]
SND_PUSHBUT- REG_EXPAND_SZ undefined HKCU - HKLM Sound Settings Page
TON_CLICK [page 54]
SND_TABCON- REG_EXPAND_SZ undefined HKCU -» HKLM Sound Settings Page
TROL_CLICK [page 54]
SND_TREE_EX- REG_EXPAND_SZ undefined HKCU -» HKLM Sound Settings Page
PAND_COLLAPSE [page 54]
Sound REG_SZ off; in accessibility HKCU -» HKLM Sound Settings Page
mode: On [page 54]
SoundLibrary REG_DWORD 0 - SAP Ethno HKCU - HKLM Sound Settings Page
[page 54]
TreeBackgroundCo- REG_DWORD 0 HKCU - HKLM SAP Note 2943146 F
lorPerLevel
UseBrandinglmage REG_DWORD 0 HKCU - HKLM Branding Page [page
26]
UseBranding- REG_DWORD 1 HKCU - HKLM Branding Page [page
Image_ReadOnly 26]
UseGuiHelpOnly REG_SZ Off only HKLM see note 694583 M
UseListColorSetting REG_DWORD 1 HKCU - HKLM Classic Design - Color

in Lists Page [page 42]
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9.2.3 Software\SAP\General\Appearance\Systems

Value

Type

Default

Reading Priority

Chapter/Reference

ColorsSystemSpe-
cific_Readonly

REG_DWORD

0

HKLM

Colors in System Page
[page 34]

9.2.4 Software\SAP\General\Appearance\Systems\SID

Value Type Default Reading Priority Chapter/Reference
ThemeNameBC REG_SZ Registry key and value  HKCU - HKLM Colors?)izr System Page
do not exist [page 34]
ThemeNameBelize REG_SZ Registry key and value  HKCU — HKLM Colors?)izr System Page
do not exist [page 34]
ThemeName Quartz REG_SZ Registry key and value HKCU - HKLM Colors in System Page
: [page 34]
do not exist
ThemeNameQuartz- REG_SZ Registry key and value HKCU - HKLM Colors in System Page
: [page 34]
Dark do not exist

9.2.5 Software\SAP\General\Appearance\Systems\SID

\Client_NO
Value Type Default Reading Priority Chapter/Reference
ThemeName REG_SZ Registry key and value HKCU - HKLM Colors in System Page
do not exist [page 34]
ThemeNameBC REG_SZ Registry key and value  HKCU - HKLM Colors in System Page
do not exist [page 34]
ThemeNameBelize REG_SZ Registry key and value  HKCU - HKLM Colors in System Page
do not exist [page 34]
ThemeNameQuartz REG_SZ Registry key and value  HKCU - HKLM Colors in System Page
do not exist [page 34]
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Value Type Default Reading Priority Chapter/Reference

ThemeNameQuartz- REG_SZ Registry key and value HKCU - HKLM Colors in System Page
Dark do not exist [page 34]

9.2.6 SOFTWARE\SAP\General\Appearance\Themes

Value Type Default Reading Priority Chapter/Reference

SelectableThemes REG_DWORD none only HKLM Theme Settings Page

20
The usable themes [page 20]

must be explicitely
specified. When using
awrong value, all
themes are displayed.

9.2.7 Software\SAP\General\Applications\<application>

Value Type Default Reading Priority Chapter/Reference
AppsSapGuiVisualTh- REG_DWORD 0 only HKLM Applications Page
eme_ReadOnly [page 45]
MouseFollowFocus REG_DWORD 0 KCU —» HKLM Keyboard Settings

Page [page 47]

9.2.8 Software\SAP\General\ControlServices

\WebSearchEngine
Value Type Default Reading Priority Chapter/Reference
WebSearchEngine REG_SZ Google HKCU —» HKLM Control Settings Page

[page 53]
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9.2.9 Software\SAP\General\Customer Colors

Value Type Default Reading Priority Chapter/Reference

CustomColors_Re- REG_DWORD 0 only HKLM Define Custom Colors

adOnly (SAP Signature) [page
27]

9.2.10 Software\SAP\General\Customer Colors\Custom

Color1l
Value Type Default Reading Priority Chapter/Reference
Hue REG_DWORD No default - value HKCU —» HKLM Define Custom Colors
must exist (SAP Signature) [page

271

9.2.11 Software\SAP\SAP Shared

Value Type Default Reading Priority Chapter/Reference

SAPhistoryDir REG_SZ_EXPAND See ref. only HKLM Roaming User Applica-
tion Directory [page 6]
History Page [page 63]

SAPWorkDir REG_SZ_EXPAND See ref. only HKLM Roaming User Applica-

tion Directory [page 6]

0.2.12 Software\SAP\SAPGUI

Value Type Default Reading Priority Chapter/Reference
DelegationMode REG_DWORD 0 HKCU - HKLM SAP Note 844095
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Value Type Default Reading Priority Chapter/Reference

StartSaplogon REG_DWORD 1 HKLM - HKCU SAP Note 552646

NoDelegate REG_DWORD 0 Only HKLM SAP Note 844095

9.2.13 Software\SAP\SAPGUI Front\SAP Frontend Server

\Accessibility
Value Type Default Reading Priority Chapter/Reference
EnhancedTabChain REG_DWORD 1 HKCU - HKLM Accessibility Page
[page 56]
SymbolAsLetters REG_DWORD 1 HKCU - HKLM Accessibility Page
[page 56]

9.2.14 Software\SAP\SAPGUI Front\SAP Frontend Server

\Administration
Value Type Default Reading Priority Chapter/Reference
Disappearitems REG_SZ 1 only HKLM SAP Note 338750 /%
ShowAdditionalTi- REG_DWORD 0 HKCU -» HKLM Visualization 2 Page
tlelnfo [page 50]

9.2.15 Software\SAP\SAPGUI Front\SAP Frontend Server

\Customize
Value Type Default Reading Priority Chapter/Reference
AdjustFontToKL REG_DWORD 0 HKCU - HKLM Encoding Page [page

60]
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Value Type Default Reading Priority Chapter/Reference
AdjustFontToSapCP REG_DWORD 1 HKCU -» HKLM Encoding Page [page
60]
AlvCellArrowNaviga- REG-DWORD 0 HKCU - HKLM 2910148
tion
AlvinitialFocusPosi- REG_DWORD 0 HKCU - HKLM SAP Note 2973107
tion
Automation.Message- REG_DWORD 8 seconds HKCU - HKLM SAP Note 87585
PendingDelay
Automation.RetryRe- REG_DWORD 10 seconds HKCU - HKLM SAP Note 87585
ply
AutoTAB REG_DWORD 0 HKCU - HKLM Keyboard Settings
Page [page 47]
BeepError REG_DWORD 0 HKCU —» HKLM Notifications Page
[page 51]
BidirectOnLang REG_DWORD 1 HKCU - HKLM Others Page [page 62]
BubbleDelay REG_DWORD 1 HKCU —» HKLM Notifications Page
[page 51]
BubbleOnTab REG_DWORD 0 HKCU - HKLM Notifications Page
[page 51]
Buttonbar REG_DWORD 1 HKCU —» HKLM Classic Design - Op-
tions Page [page 41]
CheckDynproSize REG_DWORD 0 HKCU - HKLM SAP Note 570861 %%
ColorScheme REG_DWORD 0 HKCU —» HKLM Classic Design - Op-
tions Page [page 41]
CopyAndPasteTabSe- REG_DWORD 0 HKCU - HKLM Keyboard Settings
parated Page [page 47]
DbIClkForF2 REG_DWORD 1 HKCU - HKLM SAP Note 1672400 %%
Dropdown.Keyboard- REG_DWORD 1000 milliseconds HKCU - HKLM SAP Note 352130#%
Delay_ms
Dropdown.ShowKey =~ REG_DWORD 0 HKCU - HKLM Visualization 1 Page
[page 48]
Dropdown.SortKey REG_DWORD 0 HKCU —» HKLM Visualization 1 Page
[page 48]
Edit.BlockCursor REG_DWORD 0 HKCU - HKLM Visualization 1 Page
[page 48]
Edit.CaretWidth REG_DWORD 2 HKCU - HKLM Visualization 1 Page
[page 48]
Edit.EnterFieldSelec- REG_DWORD 1 HKCU -» HKLM Keyboard Settings
tAll Page [page 47]
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Value Type Default Reading Priority Chapter/Reference
EnhancedSearch- REG_DWORD 1 HKCU - HKLM Visualization 2 Page
Mode [page 50]
Fiori.Font.Height REG_DWORD Oxfffffff2 ==-14 HKCU - HKLM Font Setting Page
[page 23]
Fiori.Font.Width REG_DWORD 0 HKCU - HKLM Font Setting Page
[page 23]
Fiori.Font.Facename REG_SZ Depends on the set HKCU - HKLM Font Setting Page
charset [page 23]
Fiori.Prop.Height REG_DWORD Oxfffffff2 == -14 HKCU - HKLM Font Setting Page
[page 23]
Fiori.Prop.Width REG_DWORD 0 HKCU - HKLM Font Setting Page
[page 23]
Fiori.Prop.Facename REG_SZ Depends on the set HKCU —» HKLM Font Setting Page
charset [page 23]
Font.CharSet REG_DWORD Set system charsetor HKCU - HKLM Font Setting Page
0 [page 23]
Font.Facename REG_SZ Depends on the set HKCU - HKLM Font Setting Page
charset [page 23]
Font.Height REG_DWORD 15 HKCU —» HKLM Font Setting Page
[page 23]
Font.Width REG_DWORD 0 HKCU -» HKLM Font Setting Page
[page 23]
GraphicSettings_Re- REG_DWORD 0 only HKLM Graphic Page [page 61]
adOnly
HideCmdLinelnplace REG_DWORD 0 HKCU - HKLM SAP Note 648452 Fw
HideCmdLinelnpla- REG_DWORD 0 HKCU - HKLM SAP Note 648452
ceAllSession
HideCmdLinePerma- REG_DWORD 0 HKCU -» HKLM Displaying OK Code
nently Field and Status Bar
Info [page 82]
ImeCloseOneByte REG_DWORD 0 HKCU - HKLM IME Page [page 59]
ImeCloseRJustify REG_DWORD 0 HKCU - HKLM IME Page [page 59]
KanjiContlnput REG_DWORD 0 HKCU - HKLM IME Page [page 59]
KanjiFontDialogProp = REG_DWORD 0 HKCU - HKLM Font Setting Page
[page 23]
KanjiFontDialogScript REG_DWORD 0 HKCU - HKLM Font Setting Page
[page 23]
KanjiHideShortcut REG_DWORD 0 HKCU -» HKLM Others Page [page 62]
KanjiKey REG_DWORD 0 HKCU - HKLM IME Page [page 59]
KanjiSuppressPFKey = REG_DWORD 0 HKCU —» HKLM Others Page [page 62]
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Value Type Default Reading Priority Chapter/Reference
LatinlAutoDetect REG_DWORD 0 HKCU - HKLM Encoding Page [page
60]
ListAllowClearType REG_DWORD 1 HKCU - HKLM Visualization 1 Page
[page 48]
ListCursor REG_DWORD 1 HKCU - HKLM Visualization 1 Page
[page 48]
ListEffect REG_DWORD 1 HKCU - HKLM Classic Design - Color
in Forms Page [page
44]
ListLines REG_DWORD 1 HKCU —» HKLM Visualization 1 Page
[page 48]
MainMenulnMoreBut- REG_DWORD 0 HKCU - HKLM Theme Settings Page
ton [page 20]
PopupBatchin REG_DWORD 1 HKCU -» HKLM Visualization 1 Page
[page 48]
PopupError REG_DWORD 0 HKCU - HKLM Notifications Page
[page 51]
PopupSuccess REG_DWORD 0 HKCU -» HKLM Notifications Page
[page 51]
PopupWarning REG_DWORD 0 HKCU —» HKLM Notifications Page
[page 51]
PositionMouse REG_DWORD 1 HKCU - HKLM Keyboard Settings
Page [page 47]
PositionTAB REG_DWORD 1 HKCU - HKLM Keyboard Settings
Page [page 47]
Prop.CharSet REG_DWORD Set system charsetor HKCU - HKLM Font Setting Page
0 [page 23]
Prop.Facename REG_DWORD Depends on the set HKCU - HKLM Font Setting Page
charset [page 23]
Prop.Height REG_DWORD 15 HKCU -» HKLM Font Setting Page
[page 23]
Prop.Width REG_DWORD 0 HKCU - HKLM Font Setting Page
[page 23]
ScrollDelay REG_DWORD 0 HKCU - HKLM SAP Note 740052 ¥
Shadow REG_DWORD 1 HKCU -» HKLM Classic Design - Color
in Forms Page [page
44]
ShowAdditionalTi- REG_DWORD 0 HKCU - HKLM Visualization 2 Page
tleinfo [page 50]
Show placeholder REG_DWORD 1 HKCU - HKLM Visualization 2 Page
characters [page 50]
Simulate Workplace REG_DWORD 1000 HKCU - HKLM SAP Note 352130 #
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Value Type Default Reading Priority Chapter/Reference
Statusbar REG_DWORD 1 HKCU - HKLM Classic Design - Op-
tions Page [page 41]
Statusbar.Layout REG_DWORD 1 HKCU - HKLM Displaying OK Code
Field and Status Bar
Info [page 82]
StatusShowMode REG_DWORD 1 HKCU - HKLM SAP Note 2565051 ¥
StatusShowModeBel- REG_DWORD 0 HKCU - HKLM SAP Note 2565051 ¥
ize
Toolbar REG_DWORD 1 HKCU - HKLM Classic Design - Op-
tions Page [page 41]
Toolbar.RegularBut- REG_DWORD 0 HKCU - HKLM Classic Design - Op-
tons tions Page [page 41]
UnderlineHotspot REG_DWORD 0 HKCU —» HKLM Visualization 1 Page
[page 48]
UseClientAccesskeys REG_DWORD AccMode enabled -1 HKCU - HKLM Keyboard Settings
otherwise O Page [page 47]
UseSaplogonLang REG_DWORD 0 HKCU - HKLM Others Page [page 62]

9.2.16 Software\SAP\SAPGUI Front\SAP Frontend Server

\LocalData

Value Type Default Reading Priority Chapter/Reference

ClearLocalTabOr- REG_DWORD 0 only HKLM Local Tab Order Page

der_ReadOnly [page 68]

DataPath REG_SZ %APPDATA%\SAP HKCU - HKLM History Page [page 63]

\SAP GUN\History

DeleteDocuments REG_DWORD 0 HKCU - HKLM File Lifetime Page
[page 66]

DeleteTraces REG_DWORD 0 HKCU -» HKLM File Lifetime Page
[page 66]

DisableHistory REG_DWORD 0 HKCU - HKLM SAP Note 925639

orDisabling Input His-
tory via Registry [page
83]

SAP GUI Administration
Appendix

PUBLIC 95


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2565051
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2565051
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/925639

Value Type Default Reading Priority Chapter/Reference

DisableLocalTabChain REG_DWORD 0 only HKLM Disabling/Setting
Read-Only the Local
Tab Order via Registry
[page 83]

DocumentLifetime REG_DWORD 0 HKCU - HKLM File Lifetime Page
[page 66]

Expiration REG_DWORD 3 HKCU —» HKLM History Page [page 63]

FieldLenHistoryOn REG_DWORD 59 HKCU —» HKLM History Page [page 63]

FileSize REG_DWORD 10 HKCU - HKLM History Page [page 63]

LocalTabOrderPath REG_EXPAND_SZ %APPDATA%\SAP HKCU - HKLM Local Tab Order Page

\SAP GUN\LocalTabOr- [page 68]
der

LocalTabOrderRea- REG_DWORD 0 only HKLM Disabling/Setting

dOnly Read-Only the Local
Tab Order via Registry
[page 83]

MaxCacheFileSize REG_DWORD 1024 HKCU -» HKLM Cache Page [page 64]

MaxCacheSize REG_DWORD 10 HKCU - HKLM Cache Page [page 64]

NoEntries REG_DWORD 20 HKCU —» HKLM History Page [page 63]

ShowMode REG_DWORD 1 HKCU - HKLM History Page [page 63]

TraceLifetime REG_DWORD 0 HKCU - HKLM File Lifetime Page
[page 66]

UseDot REG_DWORD 0 HKCU - HKLM SAP Note 867131/

9.2.17 Software\SAP\SAPGUI Front\SAP Frontend Server

\Palette
Value Type Default Reading Priority Chapter/Reference
Edit.BgndBrush REG_SZ 255255 255 HKCU - HKLM Classic Design - Color

in Forms Page [page
44]
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Value Type Default Reading Priority Chapter/Reference

Edit.FocusBrush REG_SZ 255 255 255 HKCU -» HKLM Classic Design - Color
in Forms Page [page
44]

Edit.TextInt REG_SZ 25500 HKCU - HKLM Classic Design - Color
in Forms Page [page
44]

Edit.TextNorm REG_SZ 000 HKCU —» HKLM Classic Design - Color
in Forms Page [page
44]

Frame.BgndBrush REG_SZ Same value as HKCU - HKLM Classic Design - Color

Read.BgndBrush in Forms Page [page

44]

IntensiveColorl REG_SZ 125166 207 HKCU -» HKLM Classic Design - Color

Till 196 150 207 in Lists Page [page 42]

IntensiveColor7

IntensiveTextl REG_SZ 000 HKCU - HKLM Classic Design - Color

Till 000 in Lists Page [page 42]

IntensiveText7

InverseColorl REG_SZ 192192 192 HKCU - HKLM Classic Design - Color

Till 192 192 192 in Lists Page [page 42]

InverseColor7

InverseTextl REG_SZ 00255 HKCU - HKLM Classic Design - Color

Till 5040204 in Lists Page [page 42]

InverseText7

NormalColorl REG_SZ 255128128 HKCU -» HKLM Classic Design - Color

il 27199 235 in Lists Page [page 42]

NormalColor7

NormalTextl REG_SZ 000 HKCU - HKLM Classic Design - Color

Till 000 in Lists Page [page 42]

NormalText7

Palette REG_DWORD 0 HKCU - HKLM Classic Design - Color

in Forms Page [page
44
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Value Type Default Reading Priority Chapter/Reference
Read.BgndBrush REG_SZ System- defined value  HKCU - HKLM Classic Design - Color
for "Face color for in Forms Page [page
three-dimensional dis- 44]
play elements and for
dialog box back-
grounds"
Read.FocusBrush REG_SZ Same value as HKCU -» HKLM Classic Design - Color
Read.BgndBrush in Forms Page [page
44]
Read.TextInt REG_SZ 25500 HKCU -» HKLM Classic Design - Color
in Forms Page [page
44]
Read.TextNorm REG_SZ 000 HKCU - HKLM Classic Design - Color
in Forms Page [page
44]
Static.TextInt REG_SZ 25500 HKCU - HKLM Classic Design - Color
in Forms Page [page
44]
Static.TextNorm REG_SZ 000 HKCU -» HKLM Classic Design - Color
in Forms Page [page
44]
View.BgndBrush REG_SZ Same value as HKCU -» HKLM Classic Design - Color

Read.BgndBrush

in Forms Page [page
44]

0.2.18 Software\SAP\SAPGUI Front\SAP Frontend Server

\ReleaseDebug
Value Type Default Reading Priority Chapter/Reference
Debug.Hotkeys REG_DWORD 0 HKCU - HKLM SAP Note 422044
UnhandledException- REG_DWORD 1 Only HKCU SAP Note 559285 #

sOnly
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9.2.19 Software\SAP\SAPGUI Front\SAP Frontend Server
\ReleaseDebug\ShowBorders

Value Type Default Reading Priority Chapter/Reference
CMyManager.ShowB- REG_DWORD 0 HKCU - HKLM SAP Note 324687 Fir
orders

CMyManager.Show- REG_DWORD 0 HKCU - HKLM SAP Note 324687 P
Names

ENABLED REG_DWORD 0 HKCU - HKLM SAP Note 324687 P
SHOW_ALL REG_DWORD 1 HKCU - HKLM SAP Note 324687 P

0.2.20 Software\SAP\SAPGUI Front\SAP Frontend Server

\SapChart
Value Type Default Reading Priority Chapter/Reference
Mirror REG_DWORD 0 HKCU - HKLM SAP Note 1287485

9.2.21 Software\SAP\SAPGUI Front\SAP Frontend Server

\Scripting

Value Type Default Reading Priority Chapter/Reference
DisableWriteToDisk REG_DWORD 0 only HKLM SAP Note 867260 M
RecordingWindow- REG_DWORD 0 HKCU - HKLM SAP Note 2953860 #
TopMost

SetSapWorkDirOnO- REG_DWORD 1 HKCU - HKLM SAP Note 1270130 P
penConn

ShowNativeWinDlgs REG DWORD 0 HKCU - HKLM Scripting Page [page

B 57]

Virgo REG_DWORD 1 HKCU - HKLM SAP Note 1139539 ¥
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Value

Type

Default

Reading Priority

Chapter/Reference

WaitForResponsel

REG_DWORD

HKCU - HKLM

SAP Note 867260 e

9.2.22 Software\SAP\SAPGUI Front\SAP Frontend Server
\Security

Value

Type

Default

Reading Priority

Chapter/Reference

ActivatelLogging

REG_DWORD

0

only HKLM

See chapter Central
Repository for Security
Configuration in the
SAP GUI for Windows
Security Guide

Configuration

REG_DWORD

only HKLM

See chapter Central
Repository for Security
Configuration in the
SAP GUI for Windows
Security Guide

DefaultAction

REG_DWORD

HKLM -> HKCU

See chapter Central
Repository for Security
Configuration in the
SAP GUI for Windows
Security Guide

DeleteAllUserDefined-
SecurityRules_Re-
adOnly

REG_DWORD

only HKLM

Restore & Clean Up
Page [page 79]

DisplayNotifications

REG_DWORD

only HKLM

See chapter Central
Repository for Security
Configuration in the
SAP GUI for Windows
Security Guide

DP.KeepAlive

REG_DWORD

only HKLM

SAP Note 701618 ¥4

InitSaveDir

REG_EXPAND_SZ

none

only HKLM

See chapter Central
Repository for Security
Configuration in the
SAP GUI for Windows
Security Guide
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Value

Type

Default

Reading Priority

Chapter/Reference

Location

REG_EXPAND_SZ

none

only HKLM

See chapter Central
Repository for Security
Configuration in the
SAP GUI for Windows
Security Guide

LoggingDestination-
Dir

REG_EXPAND_SZ

none

only HKLM

See chapter Central
Repository for Security
Configuration in the
SAP GUI for Windows
Security Guide

SecurityLevel

REG_DWORD

HKLM ->HKCU

See chapter Central
Repository for Security
Configuration in the
SAP GUI for Windows
Security Guide

UserRuleEditing_Re-
adOnly

REG_DWORD

only HKLM

Security Settings Page
[page 72]

UserScripting

REG_DWORD

HKCU - HKLM

Scripting Page [page
57]

WarnOnAttach

REG_DWORD

only HKCU

Scripting Page [page
57]

WarnOnConnection

REG_DWORD

only HKCU

Scripting Page [page
57]

9.2.23 Software\SAP\SAPGUI Front\SAP Frontend Server
\Trace

Value

Type

Default

Reading Priority

Chapter/Reference

SessionTrace_Re-
adOnly

REG_DWORD

only HKLM

Session Traces Page
[page 69]
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9.2.24 Software\SAP\SAPGUI Front\SAP Frontend Server

\Window

Value Type Default Reading Priority Chapter/Reference
Maximize REG_DWORD 0 only HKCU SAP Note 103019#%
9.2.25 Software\SAP\SAPGui\Administration

Value Type Default Reading Priority Chapter/Reference
UpDownload_CP REG_DWORD see note HKCU -» HKLM SAP Note 1073779
9.2.26 Software\SAP\SAPGui\Trace

Value Type Default Reading Priority Chapter/Reference
Level_ReadOnly REG_DWORD 0 only HKLM SAP GUI Traces Page

[page 70]

9.2.27 Software\SAP\SAPLogon

Value Type Default Reading Priority Chapter/Reference

AutoClose REG_DWORD 1 HKLM - HKCU SAP Note 743482#k

CertErrorHandling- REG_DWORD 0 only HKLM SAP Note 2892419

Mode

HideColumnGrou- REG_DWORD 1 (hidden) HKLM - HKCU SAP Note 806296

S OnSystemTab
pServerOnSystemTa 0 (displayed)
HideColumnMessage- REG_DWORD 1 (hidden) HKLM - HKCU SAP Note 8062967
T:
ServerOnSystemTab 0 (displayed)
SAP GUI Administration
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Value Type Default Reading Priority Chapter/Reference
HideColumnRouter- REG_DWORD 1 (hidden) HKLM - HKCU SAP Note 806296 i
OnSystemTab
O (displayed)
HideColumnSIDOn- REG_DWORD 1 (hidden) HKLM - HKCU SAP Note 806296 ¥
SystemTab
O (displayed)
HideColumnSys- REG_DWORD 1 (hidden) HKLM - HKCU SAP Note 806296 ¥
NoOnSystemTab
O (displayed)
HideColumnSystem- REG_DWORD 1 (hidden) HKLM ~ HKCU SAP Note 806296 #r
D . )
escriptionOnSys 0 (displayed)
temTab
SearchLabelBySid REG_DWORD 1 HKLM - HKCU SAP Note 864215
ShowExplorerView REG_DWORD 1 none SAP Note 1710864 7%
ShowlListView REG_DWORD 1 none SAP Note 1710864 7%
ShowTreeView REG_DWORD 1 none SAP Note 17108647
ShowWorkspaceView  pei pywoRD 1 none SAP Note 1710864
WhitelistLandscape- REG_SZ see ref. only HKLM SAP Note 2892419 ¥
FilesForlgnoringCer-
tErrors
9.2.28 Software\SAP\SAPLogon\Options
Value Type Default Reading Priority Chapter/Reference
AllowCachingServer- REG_DWORD 1 SAP Logon (Pad): SAP Logon Options -
ConfigFiles HKCU  HKLM (HKLM |C;om‘iguratio;;Files
~ HKCU) age [page 75]
ConfirmDelete REG_DWORD 1 SAP Logon (Pad): SAP Logon Options -

HKCU - HKLM (HKLM
- HKCU)

General Page [page
73]

CorelLandscapeFi-
leOnServer

REG_EXPAND_SZ

SAP Logon (Pad):

HKCU - HKLM (HKLM
- HKCU)

SAP Logon Options -
Configuration Files
Page [page 75]
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Value Type Default Reading Priority Chapter/Reference
HideToTrayBar REG_DWORD 0 SAP Logon (Pad): SAP Logon Options -
G IP
HKCU — HKLM (HKLM Be”era age [page
- HKCU) !
InitializeUserAsEmpty REG_DWORD 0 HKCU -» HKLM SAP Note 103019 ¥
LandscapeCacheEx- REG_DWORD 0 SAP Logon (Pad): SAP Logon Options -
iryPeriod Confi tion Fil
piryPerio HKCU - HKLM (HKLM Pon igura |c;r; iles
. HKCU) age [page 75]
LandscapeFileOn- REG_EXPAND_SZ SAP Logon (Pad): SAP Logon Options -
S Confi tion Fil
erver HKCU - HKLM (HKLM |:)on igura |o7r; iles
~ HKCU) age [page 75]
MessageServerTime- REG_DWORD 10 SAP Logon (Pad): SAP Logon Options -
t IP
ou HKCU - HKLM (HKLM S;”era age [page
- HKCU) ]
NoEditFunctionality REG_DWORD 0 SAP Logon (Pad): SAP Logon Options -
G IP
HKCU - HKLM (HKLM 7§nera age [page
- HKCU) ]
NoSortingToSystem- REG_DWORD 0 HKLM only SAP Note 2616226#
DescriptionInSAP-
Shortcut
PathConfigFilesLocal REG_EXPAND_SZ %APPDATA%\SAP SAP Logon (Pad): SAP Logon Options -
\Common HKCU - HKLM (HKLM (onnfiguratic;r;Files
~ HKCU) age [page 75]
SapguiNTCmdOpts REG_SZ SAP Logon (Pad): SAP Logon Options -
G IP
HKCU - HKLM (HKLM 7§nera age [page
- HKCU) ]
SAPLogonTracelLe- REG_DWORD 0 only HKLM SAP GUI Traces Page
vel_ReadOnly [page 70]
SingleSystemStatu- REG_SZ HKLM only SAP Note 2268554 #
sURL
SystemStatusURL REG_SZ HKLM only SAP Note 2268554 ¥
UseSAPLogonLangua- REG_DWORD 1 SAP Logon (Pad): SAP Logon Options -
geAsDefault General Page [page

HKCU - HKLM (HKLM
- HKCU)

73]
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9.2.29 Software\SAP\SAPLogon\Settings

Value Type Default Reading Priority Chapter/Reference
CurrentNewSapLo- REG_SZ 3 (Workspace View) HKCU - HKLM SAP Note 2336740 ¥
gonView

Other values: O (Ex-
plorer View), 1 (Tree
View), 2 (List View)

DisplaySplashScreen REG_DWORD 0 HKCU —» HKLM SAP Note 1588886 #
LastSelectedNodeKey REG_SZ HKCU - HKLM SAP Note 2336740
_Il._;:';SelectedNode- REG_SZ HKCU - HKLM SAP Note 2336740
SplashOff REG_SZ 1 HKCU - HKLM SAP Note 1588886 Pl
SplitterPosition REG_SZ splitter size of the left ~ HKCU - HKLM SAP Note 1992105 ¥

pane in %

9.2.30 Software\SAP\SAPLogon\Settings\Connections

Value Type Default Reading Priority Chapter/Reference

ColumnWidthl REG_DWORD 200 only HKCU SAP Note 1452898 #ir
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

o Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:

e The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.

e SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.

e Links with the icon &: You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such
links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Videos Hosted on External Platforms

Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any
advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within
the control or responsibility of SAP.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Bias-Free Language

SAP supports a culture of diversity and inclusion. Whenever possible, we use unbiased language in our documentation to refer to people of all cultures, ethnicities,
genders, and abilities.
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© 2022 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any form
or for any purpose without the express permission of SAP SE or an SAP
affiliate company. The information contained herein may be changed
without prior notice.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software vendors.
National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any
kind, and SAP or its affiliated companies shall not be liable for errors or
omissions with respect to the materials. The only warranties for SAP or
SAP affiliate company products and services are those that are set forth
in the express warranty statements accompanying such products and
services, if any. Nothing herein should be construed as constituting an
additional warranty.

SAP and other SAP products and services mentioned herein as well as
their respective logos are trademarks or registered trademarks of SAP
SE (or an SAP affiliate company) in Germany and other countries. All
other product and service names mentioned are the trademarks of their
respective companies.

Please see https://www.sap.com/about/legal/trademark.html for
additional trademark information and notices.
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